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Customer Support Plan

Thank you for your purchase of MasterPlan. We aim to make this
product as good as it can possibly be. Let's go over some things
you get with the product which are not so obvious.

First, is an experienced group of consultants to help you get going

and answer your questions. Second, is our continuing effort to
improve our product and tell you when updates are available, and
how you can obtain them. Third, is our policy for replacing

physically defective diskettes.
HELP HOTLINE

We want you to reach maximum performance with MasterPlan. If you
experience any technical difficulties, we will be more than happy
to help, but most of the time you will find the answer in the
product Handbook. Please check there first, or call your dealer.
If you still haven't rectified the situation, gather all the
information and pertinent facts related to your problem and call
our Customer Support Staff at (416)—4'}9—1 91 (sorry. no
collect calls). Included with your purchase of this product is 6
months of FREE technical consulting service, from date of purchase.
Please note that no assistance of any kind will be given if we have
not received your properly completed registration card .

PRODUCT UPDATE POLICY

MasterPlan uses the most advanced technology available today. But
we may create from time to time update versions of the software,

making it even more powerful and easy to use. You can take
advantage of our ongoing research -_if you send your registration
card in today! As a registered user, you will receive announcements
about major improvements in our product. These announcements give

you the cost of the update and ordering procedures. Only registered
owners receive these special update notices.

REPLACEMENT POLICY

We recognize that, despite the greatest care, disks may become
defective. Because of this, we have provided a warranty and
replacement policy. Should the diskette supplied with this program
become defective within the warranty period, we will replace it for
free. Should the diskette become damaged at any time because of
your actions, or should it become defective after the warranty
period has expired, we will replace it for a nominal fee. If your
diskette should become defective, please use the enclosed
Replacement Disk Order Form to obtain replacements.

REGISTER YOUR PRODUCT TODAY!

None of the above services will be available unless we have
received your properly completed Product Registration Card.







Product Registration

YOU MUST COMPLETELY FILL OUT AND RETURN THIS
CARD BEFORE ANY KIND OF ASSISTANCE CAN BE
GIVEN. MOST IMPORTANT, YOU MUST CAREFULLY
ENTER THE COMPLETE SERIAL NUMBER PRINTED ON
YOUR MASTER DISKETTE.

Product Name Computer

Product Serial Number

Name:

Address:

City State/Prov.
Country ZIP/Post Code:
Phone: ( )= -

Date of Purchase: / yé

Purchased From:

Address:

City State/Prov.
Country ZIP/Post Code:
Phone: ( )- -

Primary Use of Computer:

Please list the computer magazines you read:

I have read the License Agreement at the end of the Handbook and
agree with its terms as expressed therein.

Signature Date

Mail to: ISD Marketing Inc., P.0. Box 3070
Markham Industrial Park
Markham, Ontario, Canada, L3R 6G4







Replacement Disk
Order Form

Please use this form when ordering a replacement for a defective
product. Mail it, with the defective component, to the address
below. To validate a replacement request for a product under
limited warranty., include your registration card or indicate that
it is on file with ISD Marketing Inc. A product returned without
registration card is not eligible for warranty service.

If product warranty has expired, or if the product does not
qualify for warranty service, there is a minimum service fee** of
$20.00 U.S.* No out of warranty service will be performed prior to
receipt of payment by cashiers cheque, money order, or credit card
authorization.

Product Serial Number:

Product Name & Computer Type:

Name :

Address:

City: State/Prov:
Country: ZIP/PostCode:

Date of Purchase:

Reason for Return:

In the event that my product does not qualify for warranty service,
I hereby authorize ISD Marketing Inc. to charge my credit card.**

VISA M/C # exp. /

Signature:

Return defective product to:

ISD Marketing Inc., P.0. Box 3070,
Markham Industrial Park,
Markham, Ontario, Canada. L3R 6G4

* Ontario Residents add 7% sales tax
** Charges vary. The minimum service charge is US $20.00

Please allow 4-6 weeks for delivery.
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INTRODUCTION

Unpacking Masterplan

Masterplan comes packaged with a program disk, a Handbook and
registration information. The registration information includes a registration
card and a replacement order form. IMMEDIATELY COMPLETE AND
SEND IN YOUR REGISTRATION CARD. NO ASSISTANCE OF ANY
KIND CAN BE PROVIDED UNTIL WE HAVE RECEIVED YOUR CARD.

The program disk contains Masterplan as well as Help files to assist you
while using the program. You will be using the Masterplan program to create
your spreadsheets.

What Do You Need To Use Masterplan?

To use Masterplan, you will need a complete Atari 520 or 1040 ST system
(a monitor and at least one disk drive). You will need a printer to print your
work. You will also need some formatted diskettes for storing worksheets
and the like created with Masterplan.

For those of you 520 ST owners who would like to create large worksheets,
we recommend that you upgrade your computer to one megabyte of memory
with one of the kits readily available.

It is important that you read and understand the Atari ST Owner’s Manual
before you begin working with Masterplan. Areas from the manual which
are particularly helpful are the explanation of the Desktop menu and the
sections on file, folder and disk management.

Making a Backup of Masterplan

For your convenience, Masterplan is not copy-protected. Instead, we protect
the legitimate user’s right to support by carefully screening all customer
service calls to make sure that only legitimate users obtain support.
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We recommend that you immediately make a backup of the program disk
using the GEM desktop. You should always load the program from your
backup copy and only use the original for archival purposes.

Putting Masterplan on Different Media

Many of you may wish to create Masterplan 800K work disks or put
Masterplan on your hard disk. This is done the same in either case. You
must manually copy all files from the program disk which came with your
package either onto the hard disk or onto the 800K disk. Master.prg may be
placed in any folder you choose, however, the Util folder MUST be placed in
the root folder or Masterplan won’t find it and will not load.
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Introducing Spreadsheets

Electronic Spreadsheets are one of the most popular programs for personal
computers. Hardly a person exists who does not have the need to make
calculations, be they for taxes, a home budget, checkbook ledger, financial
plans, mathematics problems, or any one of hundreds of other uses. Before
computers became easily available, we had to depend on pencils and erasers
to draw up our budgets. If we wanted to change some assumption, such as
our monthly heating costs or medical expenses, we would have to erase all the
figures dependent on those figures and recalculate them. Drawing up budgets
or other financial plans was a burden, being both time consuming and messy.

Then electronic spreadsheets were introduced. The public was presented
with a better alternative to creating spreadsheets than the paper and pencil
method. Electronic spreadsheets were designed to eliminate the hassle
associated with financial planning by harnessing the power of a computer to
do the work needed.

Conventions Used in the Handbook

Several conventions are used in this Handbook for keyboard notation.
When referred to, separate key names are enclosed in square brackets. For
instance, the arrow keys are referred to by the direction each points: [Right],
[Left], [Up] and [Down]. Other keys and key combinations are referred to by
their generic names. For example, moving the screen display one screenful
over is known as paging and will be referred to as [Page][Left] (or [Right],
[Up] or [Down], depending on the direction of the page).

Special function keys are referred to by name and/or by the word
"Function" and a number. For Example, the Graph function may also be
referred to as Function 10.

Unless it is specifically stated otherwise, if we place two keystrokes in a
procedure together, press the first and, while holding the first, press the
second. For example, to make a capital letter "A", you would press [Shift][A].
If we separate keystrokes from one another (perhaps by using "and" or "or"),
press the first key, then press the second.
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In addition to using certain conventions with keyboard commands, we use
some for menu commands. In later chapters of the Handbook, we will ask
you to select a certain command and we will follow this request with a set of
characters enclosed in parentheses. For instance, we might ask you to select
the Copy command from the Edit menu (/EC). For the same command, we
might ask you to select the Edit Copy command (/EC). Each word of a
command represents a level in the command sequence. To get to the Copy
command, you have go through the Edit menu or command.
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Getting To Know Masterplan

The Masterplan Handbook has been designed to get you going with your
new program right away. Our intention is to show you how to operate
Masterplan. At the same time, we try to tie your knowledge about
Masterplan with that of spreadsheets in general.

This chapter introduces you to the basic structure of Masterplan. It
explains what Masterplan looks like and how to move about the worksheet.

The rest of the Handbook will take you through each of the menus and
explain the commands in a way that is easy to understand. Feel free to
handle just one section, or even part of a section at a time. The whole idea
is to make learning this program as easy as possible for you. Once you have
finished the sections of this Handbook, you will be ready to make your own
spreadsheets.

Loading Masterplan

To load Masterplan, first turn on your computer. Before you load
Masterplan you will have to complete the setup of three things: Your printer,
your colors and the current date. These are all controlled from the Desk
menu in GEM. Printer setup for Masterplan is the same as for general use of
your ST. See your Atari ST Owner’s Manual on the Control Panel.

Masterplan uses different display characteristics in color versus a
monochrome system. The color settings of Masterplan are the same as you
have chosen using the Control Panel in the Desk menu.

The date functions of Masterplan assume that you have set the proper date.
If you intend to use these functions, or if you want your worksheet files to
be correctly date stamped, set the date in the Control Panel.

Now that you have completed setup, insert the program disk in drive A and
get a directory of the disk. You will see the Util folder and the program
called Master.prg. The Util folder contains system files used by Masterplan.
The program named Master.prg is used to load Masterplan.
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To load Masterplan, double-click on the Master.prg icon and the program
will load and execute.

Using the Atari ST Mouse with Masterplan

The ST mouse has two buttons. GEM only uses the left button. Masterplan
uses the other one, the right one, as the equivalent of the [Return] key. You
will find this to be of great help all throughout the program. In particular it
is helpful when you are selecting ranges in response to a command prompt.
Instead of clicking the OK icon, you can just click the right mouse button.

Masterplan’s Display

After you’'ve loaded the Masterplan program, you will see this display on
your screen.

Desk File Edit Worksheet Range Graph
"4 =1 [ 0K |Cancel|Calc [Edit|Graph 7 READY

e J Ex:

HiEE—— =
) E F 6 W |le

The Face of Masterplan
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This screen display can be divided into three basic areas: The menu line at
the top; the control panel just below the menu line; and the worksheet area
comprising the remainder to the display below. The menu line at the top
contains the menu titles for the many menu commands available with
Masterplan. We will discuss these menu choices later. First, let’s get a better
understanding of the display.

The Worksheet Area

Below the control panel is the worksheet display and its borders. Heading
the worksheet is a rectangular bar with horizontal lines called a Title bar. In
the midst of it is the word "Untitled". Once you name your worksheet, its
name will appear instead of "Untitled".

At the left of the Title bar is the "Quit box". If you click the mouse button
after you have moved the pointer over the "Quit box", you will leave, or quit,
your worksheet. You are prompted as to whether or not you want to save
your work.

The "Quit box" also appears in the graph window when viewing a graph and
in the second window when you have a split-screen display. In these cases it
serves as a go-away box, closing that window.

At the right of the Title bar is the "Full box" which you are familiar with
from GEM. It works the same with Masterplan, except that the worksheet
will not cover the control panel above.

The worksheet display takes up most of the screen area. It consists of a
gridlike pattern of horizontal and vertical dotted lines. This display of grid
lines can be turned on or off by selecting Grid from the Edit menu (/EG).
The Rectangular areas formed by the grid lines are the cells. In many ways
this area is like a sheet of paper you would use to do calculating work. In
each cell, you may enter a piece of data that acts as a container for the data.

At the left and to the top of the worksheet are the borders which label rows
and columns. The rows are labeled by numbers; the columns are labeled with
letters. There are up tp 8192 rows and up to 256 columns possible in one
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worksheet. Columns start with the letter A and continue in a series. After
the columns reach Z, the series goes to AA, AB, AC and so on to IV.

As you can tell from the description above, what you see on the screen can
only be a partial display of your entire worksheet. A Worksheet can go off
the screen many times over to the right and at the bottom. In fact, the
screen display is like a gliding window which shows just a small portion of
your worksheet. You can move your "window" anywhere on the worksheet as
you are working, but you cannot see anything larger than what fits in your
screen. This is usually about eight columns by thirteen rows.

el A
PP 2227/
[This is an /]
2 Yarea of the o
y
o [worksheer 7, You can see
| you may see
on the screen

VPIIIPD.

~

other areas of the worksheet

by moving the window

8192

Moving the Window Over the Worksheet

Until you print your worksheet, you will not be able to see the entire
worksheet at one time. The Screen display can, however, be split so that you
see two sections of your worksheet from different areas (see the Worksheet
commands, Windows and Titles).

By now you will have noticed the pointer which moves when you move the
mouse. This pointer has different functions depending on where it is on the
display. While in the worksheet, the pointer has the shape of a cross, and is
called the cell pointer because it is used to select cells. When it leaves the
worksheet, it becomes an arrow for selecting menus and other items. The
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pointer becomes a hand when it is over the column dividers and you drag the
divider to change the width of a column.

As we’ve mentioned. the cells in the worksheet are usually divided by lines
for neat formatting. Notice that one cell is shown as a dark block. In this
cell rests the cell indicator. The cell indicator indicates the cell which will be
affected by data entry or which is the starting point for any command.
Whenever you want to write something in a cell, you must move the cell
indicator to that cell.

Desk File Edit Worksheet Range Graph

[~ 4 =3 [OK [Cancel] Calc [Edit]Graph | READY
wi| o7
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The Pointer and the Cell Indicator

You can move the indicator in several different ways, the two simplest
being by pointing (moving the cell pointer) to a different cell and clicking
the mouse button, or by using the arrow keys to move the cell indicator.
Feel free to try moving about using either way.

Acting as borders at the bottom and to the right of the worksheet are the
Scroll boxes. These areas are for controlling movement of the screen display.
For those of you who are using a mouse, they offer a convenient and easy
way to move your screen display. The figures in the Scroll boxes are for
scrolling, paging and gliding (discussed later).
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At the lower right side of the worksheet display, in the corner where the
lower and right Scroll boxes meet, there is the Size box. It works just like it
does in GEM. You may size the worksheet window for your special needs.
For example, you might wish to display a graph along side your worksheet.
If you have split windows, you can size each window. Regardless of how
you size your windows, whenever you open a new file or erase the current
one, the worksheet will return to the default size.

The Control Panel

The area above the worksheet display is the control panel. It controls data:

entry, editing, worksheet movements and messages. At the extreme left of
the control panel is the Express icon, which controls nine movement
commands. Next to the Express icon is the Help icon and a row of icons for
common functions.

The control panel contains an Icon bar at the top, the Status line in the
middle, and the Edit line at the bottom. The Status line is so called because
it displays the contents and the status of the cell in which the cell indicator
resides. The first part of the line is the cell locator. The cell locator gives
the current location of the cell indicator, or where you are in the worksheet,
by displaying its address (the column letter and row number of the cell). If
you have used the scroll bars to move to a part of the sheet other than where
the cell indicator is, you may click on the cell locator to return to the cell
indicator’s position.

Next to the cell locator is space for displaying cell contents. Whenever the
cell indicator rests in a cell in which a format command has been invoked or
data entered, the data and command status will be shown in the space next to
the cell locator. The data is shown in full. The format commands are shown
in abbreviated form with parentheses around them.

10
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___Desk File Edit Worksheet Range Graph
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The Status Line Displaying a Cell’s Contents

The bottom line is the Edit line. The rest of the Edit line is used when you
enter the Edit mode. A duplicate version of the entry on the Status line
appears on the Edit line for you to work with. The Edit line is also used to
display help messages and prompts which assist in implementing commands.

The top icon bar contains status and function icons. It also contains the
mode indicator. The mode indicator usually tells you which of the several
modes or processes the program is in: Value, Label, Point, Edit, Menu, Error
and Wait among others.

The mode indicator also serves as the mouse equivalent of the [Break]
function. Whenever you click on it, you are returned to the Ready mode.
At the left side of the icon bar is a Cancel icon. This icon is the mouse
version of the [Escape] key. The Break and Escape functions are discussed
later in this chapter.

11
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Masterplan’s Icons

By now you should be wondering what the Express icon and the other icons
are for and how they are used. Icons have two purposes: to inform or to be a
function. Many icons appear on the icon bar of the control panel only when
you have entered a certain mode or to remind you of an active status. Other
icons provide a convenient way to implement a command. For instance, the
Calc icon provides an easy way for you to recalculate the sheet. To
recalculate you need only click on the Calc icon.

The icons may either be active of inactive. When they are active, they
appear bright, and may be clicked on. When they are dim, the icons are
inactive and are not available. The icons which appear in the control panel
are displayed below.

Express Comfirm Escape Recalculate Edit  View Graph Tab Scrollock Capslock Mode Indicator
Bhee e SN N g/ e s

e SR el g ik
T4 ok cancel] Cale | Edit | Graph|{R 4%~ End ScrCapd  READY|

r Al: Status Line 3
. i | [dit Line
e e i A

e % /
Corners Tabbing Rotate Help Cell Locator Protection Circular Reference Mouse Dreak

Icons in the Control Panel

The largest icon, the Express icon, is constantly visible at the left of the
control panel. This icon is used for moving the cell indicator several
different ways, depending on which part of it the pointer is over when you
click the mouse. How to use the Express icon is described in the section
"Using a Mouse to Move Around" of this chapter.

The other icons consist of a Help icon, an OK icon, a Cancel icon, icons
for Edit and Graph, a Calc icon, a Circular Reference icon, a Protect icon, a
Capslock icon, a Scroll Lock icon and an End icon. Aside from the Help,
Calc, OK, Cancel, Edit and Graph icons, these icons only appear when

12
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invoked, and they disappear when they no longer apply. Each of these icons
is discussed briefly below. Further discussion of the individual functions can
be found throughout the rest of the Manual, in the sections which apply to
them.

We have already discussed the Cancel icon. The OK icon is used to
confirm a command or selection, and is equivalent to pressing [Return]. It is
available with any command which was started using the mouse. Many of
you will find clicking the right mouse button to be more convenient since it
has the same effect as clicking OK or pressing [Return].

Another permanent icon is the Help icon. The Help icon is used to obtain
context sensitive help. At any time while using the program, you may click
on the Help icon to get instant help about the command or function you are
using. This has the same effect as hitting the [Help] key or [Function 1].

The Edit icon is used when you wish to edit the contents of a cell. Just
click on Edit and you will be placed in the Edit mode, discussed later in the
Handbook. This icon is equivalent to pressing [Function 2].

The Graph icon is used to view your current graph. When you click on it,
a graph will be displayed using your latest settings and selections. This icon
is equivalent to pressing [Function 10].

The Calc icon appears when you are in Manual calculation and have entered
any data. This icon indicates that your worksheet might need to be
recalculated because a change has been made. When you click on it, a
recalculation will occur. This has the same effect as pressing [Function 9].

The End icon appears when you have pressed the [Insert] key to indicate
that the next time you press an arrow key, you will tab in that direction. It
is called End because it moves you to the end of a series in the direction of
the arrow key pressed.

13
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The Circular Reference icon appears during a calculation of your worksheet
if a circular reference is fcund. Circular references may cause problems in
worksheet calculations because they consist of two cells with formulas which
depend on one another and therefore cannot be resolved without changing
one reference.

The Protect icon appears to indicate that global protection was enabled.

In addition to the icons described above, other icons indicate statuses.
When you have pressed the Capslock key, a Capslock icon will appear. When
the Scroll Lock facility is enabled, the Scroll Lock icon appears.

Moving Around the Worksheet

Now that you know what all the elements of the worksheet are, it’s time to
learn more about how to use the worksheet. The first thing to learn is how
to get around so that you can enter data.

Convenient methods for getting around a spreadsheet are essential since
much of your work will involve moving around to enter data, altering ranges
and comparing different parts of your spreadsheet. Masterplan has a wealth
of ways to get you where you want to go and to get you there quickly.

Many of you will prefer to use the mouse to move around; still, there will
be times when using the keyboard will be the most convenient method.
Because of this, we have built in similar movement functions for both
methods to make sure you can get around just as easily either from the
keyboard of with the mouse.

Using a Mouse to Move Around

When you move the mouse, you control the pointer. When the pointer is
over the worksheet, it has a cross shape. You can move it freely over any
cell on the screen. To select any cell, just click the mouse button when the
pointer is over the cell. When you have selected a cell, the cell locator in the
control panel is updated to show the new location.

14
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It is important to remember that the cell indicator is "where the action is."
All commands and data entry affect only the cell where the cell indicator
resides. Yet the pointer can move anywhere, even to parts of the worksheet
currently off the screen. Because of this, you have to remember to click on a
cell if you want to select that cell; placing the pointer over the cell is not
good enough.

Movement around your worksheet with the mouse is very easy. At your
disposal are the Scroll bars, Scroll arrows and Express icon.

The Scroll bars at the right and bottom of the worksheet allow you to glide
to distant parts of the worksheet in a hurry. Their use is very simple. Just
move the pointer over the box, or "thumb", in the Scroll bar, hold the mouse
button down and drag the thumb across the bar by moving the pointer. If
you instead click in the scroll bar to either side of the thumb, your worksheet
will page in windowful in the direction desired.

Remember that if you want to enter data or execute a command at this new
location, you must select a cell. If, instead, you only wanted to go to the :
new location to check on some data, a simple way to return to the position of
the cell indicator is to click on the cell locator in the control panel.

The Scroll arrows in the Scroll bars have two functions. First, clicking on
the arrows will move the worksheet in the desired direction one cell at a
time. Second, if you hold the [Shift] and click the mouse on any of the
arrows, your worksheet will page one windowful in the direction desired.
You will find this of great help in paging up since the thumb on the right
side moves so very little with each page down (after all, there are nearly 700
possible pages in 8192 rows).

The Express icon has already been introduced. Movement with the Express
icon is tied to data you have entered. The four corners control movement to
the four corners of your current worksheet. The four arrows control tabbing
to the end or beginning of data blocks (depending on where you are). The
center controls movement of the cell indicator within a selected range.

15
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Using the Express Icon to Move the Cell Indicator Home

Tabbing is a special feature which you will learn to appreciate. It is useful
not only for moving around the worksheet, but also for selecting ranges of
data for commands. This is the equivalent of pressing [End] and then the
arrow key for the desired direction. Its use is simple. Any time the cell
indicator is on a cell with data and you use a tab, the indicator will move to
the last cell containing data in the direction chosen. If the cell indicator is in
a blank cell when you tab, it will be moved to the next cell containing data
in the desired direction.
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Tabbing Down

Using Arrow Keys to Move Around

As was said before, your actual position in the worksheet is reflected by the
dark cell indicator. Unlike with the mouse, when you use the keyboard to
move around the worksheet, all movement is tied to the cell indicator since
the keyboard cannot easily be made to control the pointer. The simplest
movement is done by using one of the four arrow keys to move the cell
indicator one cell at a time in the desired direction.

The arrow keys can move you to any cell of the spreadsheet. However,
they cannot move the cell indicator beyond the boundaries of the spreadsheet
(for example, they can’t move the cell indicator to the Status line). If you
should attempt to move past its edge, the computer will beep and the cell
indicator stops moving at the border cell.

However, you can move about inside the spreadsheet while moving the
window display with you. This is done by moving the cell indicator to the
right or down until you reach the end of the display. If you press the arrow
key again, your worksheet will scroll in the direction of the arrow key you
pressed, one row or column at a time.

| 17
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Moving in Leaps and Bounds

There are also ways to move quickly about your sheet using keyboard
commands. You can use your arrow keys, or a combination of arrow and
other keys, to move in screenfuls or to move to the bottom right and the top
left cells of the worksheet you’ve created (these are considered Home and
End). You can also move to the top right and bottom left cells.

Moving by screens, or paging, is done by pressing [Shift] and the arrow
pointing in the direction desired. [Tab] and [Shift] [Tab] will also page to the
right and left. [Home] will move you to the top left corner of your work
area and [Insert] [Home] will move you to the bottom right corner of your
work area.

Tabbing, the function of moving through blocks of data, is done in a two-
step process. After the cell indicator is in the cell you are starting from,
press [Insert]. You will notice that the End icon appears in the control panel.
Next, press the arrow key pointing in the direction of your choice. This will
erase the icon, and move the indicator to the end or beginning of the block
desired. You could also press [Insert], then [Home] to move the cell indicator
to the end of your current worksheet.

Once you press [Insert], the End icon remains on the screen until you press
an arrow key or until you press [Insert] again to turn it off.

Movement Keys Summary

Page right [Shift][Right] or [Tab]
Page Left [Shift][Left] or [Shift][Tab]

Page Up [Shift][Up]

Page Down  [Shift][Down]

Top Left [Home]

Bottom Right [Insert][Home]

Tab [Insert] plus arrow key

18
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Tying the Cell Indicator to Worksheet Movement

Masterplan provides another feature for moving the screen display over the
worksheet using the keyboard. This feature is known as scroll locking.
When you press [Shift][Home], you are linking the movement of the arrow
keys to that of the screen. It causes movement of the cell indicator using
arrow keys to be synchronized with the worksheet display. The Scroll Lock
icon appears in the control panel when you have enabled Scroll Lock. Every
time you use an arrow key to move, the screen is also moved the same
amount of cells. To unlock scrolling, press [Shift] [Home] again.

The key combinations for moving by pages and the scroll bars won’t
operate while you are making use of this function, nor will commands such
as the Worksheet Titles command.

Using the GoTo Function

A convenient way to move the cell indicator to a particular cell is by using
the GoTo function [Function 5]. This command allows you to specify a cell
address (or coordinates of a cell) where the cell indicator is to be moved. It
is invoked by pressing [Function 5]. In response to a prompt for a location,
type the column letter and the row number designating the cell’s location. As
you type, the address will appear on the Edit line in the control area of the
screen. Enter the cell address by pressing [Return]. Your position in the
worksheet will immediately be changed to the specified cell.

Protected Cells

There is one instance when you will find you can’t move into certain cells
of the worksheet. These cells are protected. The reason for protected cells is
that there will be times when you put certain information in your
spreadsheet that you don’t want changed no matter what else is changed. An
example of a cell you might want protected is one which contains an
important formula.

Cell protection can be enabled and disabled from two different menus: the
Worksheet menu (see Worksheet Commands in this Handbook) and the Range
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menu (see Range Commands in this Handbook). When Worksheet protection
is enabled a Protect icon will appear in the control panel. The Worksheet
Titles command is another command which creates protected areas. These
titles can only be entered by using the GoTo function [Function 5], or by
using your mouse.

Introducing Menus

As mentioned before, the top row of the screen contains command menus.
Masterplan has many commands to help you with the creation of your
worksheets. Some commands are done with the mouse, or arrow keys, while
others are placed in menus.

Each of the menus has a series of selections to cover a specific aspect of
the program. Many of these selections also have their own selections as well.
You will learn more about these commands in the upcoming chapters. At
this point, we only want to give a general idea of how to use the menus.

Menu commands may be invoked either with the keyboard or with the
mouse. The command MUST be completed with the same method. You will
notice that if you started with the mouse, the keyboard will be inactive, and
vice versa.

With a mouse, menu commands are invoked just as they are with GEM.
Point at a selection in a menu and click. Often after you make a selection, a
new menu line will appear with another set of selections. These selections
may also have menus. In fact, it is possible to go through menus several
layers deep, and so you may want a way to get back to a previous menu, or
back to the Ready mode. To go back to the last menu, click on the Cancel
icon; to return to the Ready mode, click on the mode indicator.

The menu commands may also be invoked from the keyboard; either by
typing command letters or by using the arrow keys. Note, however, that the
Desk menu cannot be reached from the keyboard, but only with the mouse.
Whether you use the command letters or the arrow keys, the first step is to
press [/]. This causes the mode to change to Menu and the main menu items
to become active. To select the Worksheet Window command by typing
letters, you would press [W] (the first letter in the word worksheet). The
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main menu is replaced on the menu line by the Worksheet menu. To select
Window from it, you would press [W] again. The Window menu appears on
the menu line and you may select one of its commands.

If, instead, you choose to use the arrow keys, from the Ready mode press
[/]. Now you can move back and forth along the menu line with your [Left]
and [Right] arrow keys. As you pass over each item, it is highlighted. To
choose one of the items, press [Return] when your item is highlighted. The
main menu will be replaced by the menu of the item of your choice. You
may choose an item from this menu just as you did the first one. In this
way, you can move through the menus one by one until you are finished.

Escaping and Breaking Out of Commands

There are two commands to help you get out of just about any place in the
program. One is Escape and the other is Break. Escape is the less drastic of
the two. Escape is invoked either by pressing [Escape] on the keyboard, or
by clicking on the Cancel icon in the control panel. It is used to escape
partially out of commands. It usually takes you to the previous step, whether
it is the last menu, the last command prompt or the last mode.

Break is used to take you completely out of a command or prompt series.
It is invoked either by pressing [Control] [Undo] or by clicking on the mode
indicator (Ready, Point, Menu, etc.). You will find it particularly helpful
when you want to break out of several layers of menus in one shot.

How to Get Help

Masterplan comes with built-in help to assist you in learning to use the
program. Either press [Help], [Function 1] or click on the Help icon
(question mark) in the control panel. A menu will appear for you to select
the subject about which you want help.
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Selecting a Range

Many of the commands of Masterplan involve selecting a range of cells
which will be the object of a command. The Range, Copy, Erase and Move
commands require such range selections, although ranges must also be
selected for many other commands. Some commands, such as the Copy
command, even require that you select a source range and a target range.

First, just what is a range? A range is a group of contiguous cells. It can
be as small as one cell or as big as the entire worksheet. Of course, it can
also be any rectangular area in between. The one thing that a range cannot
be is an area of cells which can’t be defined by two points. The top left cell
(the start or anchor cell) and the bottom right cell (the free or end cell) of
the range defines its parameters. These two cells can be one and the same,
defining a single cell.

Single-cell Range Row Range

0] ok ,
L I A A Y
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//////
w, \
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\

Column Range This is not a Range Rectangular Range

Illustration of What Constitutes a Range

Range selection is done by using either the keyboard or the mouse.
Whenever you need a range, you will be prompted to specify its parameters.
At the same time, the cell indicator changes to indicate that it is awaiting a
range selection.
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If the range consists only of one cell, you can move the cell indicator over
that cell and press [Return]. If the range consists of a rectangular area, the
easiest way to specify the range is by dragging the pointer with the mouse
(that is, holding the mouse button down while you move the pointer).

Actually, using the mouse gives you another option: specifying the range
before beginning the command. In either case, to specify the range, press the
mouse button down while the pointer is over the anchor cell, then drag the
pointer to the range’s end cell. A dotted-line rectangle will follow the
pointer. When you let up in the mouse button, the range of cells covered by
the dotted rectangle will be highlighted as the selected range, with the end or
"free" cell highlighted differently in the point mode.

When you are creating your range, why don’t you try moving all around the
worksheet while you are holding the mouse button down? Notice how the
range parameters change. While you are holding the mouse button down, you
can change the borders of your range as much as you want. Only when you
let up on the mouse button is the range actually selected and the borders
determined.

Until you press [Return] or click OK in response to the range request, you
may freely alter the range. To do so, move the pointer to the cell to be the
new free cell, press the [Shift] key and click the mouse button. you can do
this as often as you like.

In fact, this [Shift] click procedure can also be used to specify a range
which can’t be displayed on the screen at one time. With the anchor cell
selected, you can use any of the mouse movement commands to go anywhere
on the worksheet. When you get to where you want to go, [Shift] click the
desired cell as the free cell to select the range.

You may instead elect to use the arrow keys to select your range. This
method may only be used after a command prompt asking for a range. To
use your arrow keys, place the cell indicator on the start cell. Next, press [.]
once to set that cell as the anchor cell. Now, use the arrow keys to move the
cell pointer wherever you wish. You will notice that the selected range
becomes highlighted as you move. If you go too far and pass the end cell
you want, you can back up until the cell indicator is over the right cell.
Once you are satisfied with your range, press [Return] to enter it.
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When using the arrow keys, you may also use any of the tabbing, paging or
other worksheet movement commands to get to the end of your range. The
area covered during the move will be highlighted as part of the range.

Another option for entering the range is to type the cell addresses of the
range. Just type the cell address of the start cell, a period and the address of
the end cell. It will appear next to the prompt as you type. You will see two
periods separating start and end cells, instead of the one you typed in. This
is normal. Press [Return] to enter the range when you are finished.

While you are in the process of specifying your range, you may need to
alter it. The [Escape] and [Backspace] keys are used to change the range.
[Escape] will back you one step at a time through the process, first to the
start cell, then back to the command. [Backspace] will only take you back to
the start cell from the end cell. In a command which asks for a source range
and a target range, once you have pressed [Return] to set the source range,
only [Escape] will return you to the original command; [Backspace] will have
no effect.

The range selection feature offers one other convenience. You have noticed
that the start cell serves as a pivot for the range. This is why it is also called
the anchor cell. When creating a range, you can rotate the anchor cell in a
clockwise motion by pressing [.]. The free cell also moves clockwise to keep
opposite from the anchor cell. The mouse equivalent of this is the block
shaped cross inside the Express icon. Each time you click your mouse while
the pointer is over this cross, you are moved clockwise to the next corner.

47 —
L 3 2

The Anchor Rotation Figure in the Express Icon
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Once you’ve created a range, you can name it with one of the Range Name
commands. Naming ranges can be very useful. For example, you might wish
to name different parts of your worksheet to create ranges for printing. You
can also name ranges to simplify formula entry. Why not name your cells for
their functions, such as 'Profits", "Costs" and the like. In several cases, you
will find it easier to refer to a cell or group of cells by their range name
instead of by their location. This is mainly because it is easier or remember
the name of something rather than its address.
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A SUMMARY OF WORKSHEET BASICS

Setting Entrys

When in any cell, you can type an entry (value, formula or label) or issue a
command. If you type an entry, you must enter it in the cell by pressing
[Return] or by using one of the movement keys. While you are typing the
entry, it will appear across the Edit line so you can see if you are making
mistakes. A blinking cursor indicates the position of your next potential
character. If there was an entry already in the cell, you can choose to edit
the existing entry by going into the Edit mode or you may simply replace it
with a new one by typing the new one in and entering it. The entry of the
current cell appears on the Status line as well as in the cell.
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Editing an Entry

[Return] is used to enter (or set) values, labels and formulas in a worksheet.
It signals to the computer that you have finished keying in the information
and that the computer can now process it. If you are using a mouse, clicking
the right button or OK is an alternative to pressing [Return].
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The arrow and other movement facilities can also be used to set entries in
the Label of Value modes. After setting the entry, a movement key will
move your position on the worksheet according to its function. For example,
you may use [Right] to set an entry. After it sets the entry, it moves the cell
indicator one cell to the right. Except for paging commands and [Up] and
[Down], the movement keys are not used to enter data from the Edit mode.
This is because the Edit mode has its own uses for the movement keys.

Different Types of Entries

When you enter data, Masterplan knows the difference between the three
possible types of entries by the prefixes used or by the first character of the
entry. It is important that Masterplan be able to tell the difference between
these entries because each is used differently.

Values are the simplest type of entry. They can be used by calculations in
other sections of the worksheet. Values are typed in as a number and
[Return] is pressed to enter it. No prefix is needed.

Labels, unlike values, are usually text. They act as headings or explanations
and are not used to calculate other areas of the worksheet. If you start
typing text rather than numbers or number indicators (such as operational
signs), Masterplan understands that you are entering a label and goes into the
Label mode.

An interesting difference between values and labels is that if a value does
not fit into a cell, Masterplan remembers it but does not display it unless a
format is used which allows a value to change to an exponent. Instead,
asterisks are displayed throughout the cell. Labels, on the other hand, can
spill over into the cell to the right if they do not fit within a cell, provided
that the cell to the right is empty. This feature allows text processing. You
are not limited to one word titles. Instead, you can add sentences or even
paragraphs of explanatory text to your worksheet.
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A Label Spilling Over into Another Cell

There are four label prefix characters which are used to indicate individual
alignment for labels. If there is any doubt about whether you are entering a
number or label, these label prefixes are: ’ for left alignment, " for right
alignment, ~ for centering and \ for repeating the keystroke series across the
cell. For instance, if you have a label such as "3rd Quarter", Masterplan
might assume that it is a value from the first character. However, if you use
the * character as a label prefix, there is no doubt that you intend it to be a
label and that it should be aligned to the left edge of the cell. Label prefixes
are discussed further in the "Range Commands" and "Worksheet Commands"
chapters.

Commands which also use letters are preceded by the command prefix (the
"/" character) so as not to be confused with labels.

Formulas are basically values. We only discuss them separately from values
because they are more complicated than the average value. A narrower
definition of formulas is that they are calculations which result in a value. It
is this resulting value and not the formula which is usually displayed in the
worksheet. Formulas are discussed fully in the chapter, "Building Formulas
Using Operators and Functions.
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Using Different Modes

Masterplan distinguishes between the process used for entering a
value/formula and entering a label by using different modes. These and
several other modes are important when you consider that different things are
done in each mode. For instance, the Point mode allows you to point to cells
(or use cell addresses) as parts of formulas.

There are several different modes and processes used by Masterplan. The
more frequently used ones are: Ready, Label, Value, Point, Edit, Menu, Error
and Wait. Each mode governs which actions you may take and the effects of
certain commands or keystrokes. The mode you are in is shown by the mode
indicator.

The Ready mode is the one in which the program starts. When you
complete some action, Masterplan returns to the Ready mode in preparation
for your next action. From this mode, you are allowed to issue a command
or start entering data. When you are in the Ready mode, you can also use
your mouse and movement keys to move to any part of the worksheet.
However, when you start invoking menu commands, the Ready indicator is
erased from the screen. Until you are finished with or escape from the
command sequence, you will not be able to move about your worksheet (this
excludes such things as specifying ranges in response to prompts).

When you start typing a label prefix or text (excluding commands),
Masterplan places you in the Label mode. Anything entered while you are in
the Label mode is treated as a label, not as a value/formula even if it is a
number. Labels have different properties than values. The differences will
become more apparent as your experience with Masterplan grows. You must
complete the entry or press [Escape] to return to the Ready mode before you
can move around the worksheet.

When you start typing a number or a number indicator (such as an
operational sign), Masterplan places you in the Value mode so that you may
enter a formula or a value. When you have entered the value or if you press
[Escape], Masterplan returns to the Ready mode.
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If, at some point when you are entering a formula in the Value mode, you
start to point at a cell which is to be included in a formula, Masterplan will
immediately change to the Point mode. Once you have pointed to and set a
cell reference in a formula, Masterplan returns to the Value mode.
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Pointing to a Cell

The Edit mode is used for both labels and values. It provides you with
more sophisticated editing procedures than those otherwise available. The
Edit Mode causes a value or label entry to appear on the Edit line as well as
on the Status line. A Blinking cursor appears at the end of the entry. You
may move this cursor to any character of the entry and change that part
without affecting the rest of the entry. When you re-enter the value or label
mode, the newly edited version will be used.

Menu appears in the mode indicator when you are selecting one of the
menu commands. Until you are finished with a command sequence, or use
[Escape] or [Break], you are limited to making the choices offered by the
commands. You cannot start a command sequence, then, in the midst of it,
choose to move around the worksheet and edit some entries.

The Error mode only occurs when Masterplan realizes you have made a
mistake. The mode indicator changes to "Error". A prompt may be displayed
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on the screen to explain the type of mistake you have made. Once you have
corrected your mistake (you may also have to confirm one of the options
associated with the prompt), the prompt disappears and the mode indicator
returns to Ready.

The Wait mode is used when Masterplan is processing a command. During
this mode, no cornmands can be invoked or data entered.

How Modes Affect Keyboard Commands

As we stated earlier in this section, different key strokes have different
effects in each of these modes.

In the Ready Mode:

When you are in the Ready mode, the mouse and the movement keys are
used to move you around the worksheet. The movement commands are
described in "Getting to Know Masterplan". From the Ready mode, you may
also begin to enter data or invoke a command.

In the Label, Value or Point Modes:

In the Label or Value modes, you have several functions available, These
functions are [Escape], [Break], [Delete] and [Backspace]. The functions are
also available in the Point mode, but their use is slightly different then.
[Escape] and [Break] are used in command sequences as well as in modes to
move you backward one step at a time (with [Escape]) or through the whole
series back to the Ready mode (with [Break]).

By using [Escape] before you enter a label or value, you can cancel your
entry and return to the Ready mode. Pointing to the Cancel icon and
clicking the mouse button has the same effect as [Escape] on labels or values
- it cancels the entry on the Edit line.
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Another function used in the Label and Value modes is [Backspace]. When
[Backspace] is used while typing a label or value, Masterplan moves the
cursor one space back and erases the character.

To Use: Press:

Break [Control][Undo]
Escape [Escape]
Backspace [Backspace]

If you are entering a formula and pointing to cell addresses, you are placed
in the Point mode. To go back to the Ready mode from there and without
setting the formula, you may use [Escape] twice. On the other hand, if you
are in the Point mode, you may issue a [Break] as a shortcut. A [Break] will
move you back to the Ready mode by automatically causing you to [Escape]
from each mode you have gone through since you last left the Ready mode.

Not only do you revert to the previous mode each time you press [Escape],
but, when you are in the Point mode, any cell you have just pointed to has
its address removed from the formula you are entering. Using [Escape] may
therefore result in a circular reference formula (a formula which uses a
reference which depends on the formula). It deletes the cell reference you
just made while replacing it with the cell address of the formula cell.

In the Edit Mode:

The Edit mode may be entered in one of two ways. First, you may choose
to enter the Edit mode whenever you are in the Ready, Label or Value modes
by pressing [Function 2] or clicking on the Edit icon. In addition,
Masterplan automatically places you in the Edit mode whenever you are
prompted for data input from a command, or whenever you have made an
error in data input. When in the Edit mode, the following keys have the
specified functions.
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Edit Functions

If You Press: You Will:

[Delete] Delete the character under the cursor
[Backspace] Delete the character preceding the cursor
[Home] Move to the entry’s first character
[Insert] Move to the entry’s last character
[Tab][Right] Move five characters to the right
[Tab][Left] Move five characters to the left

[Right] Moves one character right

[Left] Moves one character left

*Any character key: Insert text

In addition to the [Delete], [Backspace] and movement functions, you may
also insert characters while you are in the edit mode. Masterplan does not
replace already existing characters with those which are inserted. Instead,
inserted characters are simply added at the spot indicated by the position of
the cursor.

The movement keys are used in the Edit mode to move to a certain area in
the label or value that needs to be corrected. [Backspace], [Delete] and the
insert feature are used to correct the mistakes.

The arrow keys use the same repeat feature used in the Ready mode.
Instead of having to press the arrow key repeatedly to move more than one
space, you can continue to hold the key down after pressing it.

Special Functions

Masterplan has eight special functions which help with various aspects of
the program. These special functions are discussed further in the areas which
pertain to them. However, we would like to present you with an overview-of
them now.

The functions can be reached from the keyboard by using the function
keys. The following is a list of the functions.
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Function Number Function Name

Help
Edit
Name
Absolute
GoTo
Window
Calculate
Graph

H WK -

—
o OO\ W

[Function 1] is the Help function. If you are using a mouse, you may also
get help by clicking on the Help icon in the control panel. From the
keyboard, you may also press the [Help] key. If the Help disk isn’t in the
disk drive, you will be prompted to insert the Help disk. Help offers you
condensed explanations of commands available to you about different aspects
of the program.

[Function 2] is the Edit function. From the Ready mode, this invokes the
Edit function. You can also enter the Edit mode by clicking on the Edit icon
in the control panel. If you are in the Edit mode and select Edit, Masterplan
moves to the mode you were in before entering the Edit mode.

[Function 3] is the Name function, In the Point mode, when you are
prompted for a range, this function displays a list of your current named
ranges. You may clear the list by choosing a name or pressing [Escape].

[Function 4] is the Absolute function. While in the Point mode, it causes
the cell or range you are referencing in a formula to be relative, absolute or
mixed reference (see "Building Formulas Using Operators and Functions" for
a discussion of the three types of references). Before using [Function 4],
point to the cell whose address you wish to use in the formula. Press
[Function 4] to make the cell reference absolute. If you continue to use the
Absolute function, the address will cycle through the possibilities from
completely absolute to mixed to completely relative. When the desired
reference type has been obtained, you may go back to the formula.

Example: Using Al = $AS1 - AS1 - Al - Al - $ASI ...
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[Function 5] is the GoTo function. This function along with a typed and
entered cell address, moves you to that cell whether it is protected or not. It
can also be used to reach cells normally inaccessible in the Titles area
(created by the Worksheet Titles command.

[Function 6] is the Window function. This function is used after you have
created split windows with the Worksheet Windows command. By using this
function, you can move from one window to the other. If you are using a
mouse, you may also move the cell pointer from window to window and click
the mouse.

[Function 9] is the Recalculate function. It forces a recalculation of the
entire worksheet. The Calc icon in the control panel serves the same
function. It may be used at any time. However, it is usually used in either
of two situations. The first is when you have elected to use manual
recalculation. When you enter data after having selected manual
recalculation, the program will not recalculate the worksheet automatically.
Instead, you must manually force recalculation when you have finished
entering your data. Whenever manual recalculation has been selected and you
have entered any data, the Calc icon will be highlighted indicating that your
worksheet needs to be recalculated. To recalculate your worksheet, click on
the Calc icon or press [Function 9].

The other use for the Recalculate function is to calculate the result of a
formula -- a sort of built-in calculator. Whenever you are in the Value or
Edit modes and are working on a formula, you may select the Recalculate
function to compute the result of the formula on the Edit line. Since this
will permanently change the formula into the resulting value, if you wish to
continue to use the formula as is, you should first enter the formula into a
cell and then perform this function in the Edit mode when you have a
duplicate of the entered formula. When you press [Escape], the calculated
version of the formula is erased, while the previously entered version
remains.

[Function 10] is the graph function. The Graph icon in the Control panel

performs the same function. Used from the Ready mode, it allows you to see
the most recently drawn graph. This function is particularly helpful when
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you are working on a graph and want to see how all the changes made in a
worksheet affect your graph. Once you are finished viewing the graph, you
can return to the worksheet by pressing [Escape], clicking in the Go-away
box or by clicking in the worksheet window.
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BUILDING FORMULAS USING
OPERATORS AND FUNCTIONS

Introduction

This chapter defines formulas and describes how they can be built using
operators and/or functions. An entire chapter is being devoted to formulas
because, unlike labels or other value entries, the creation of formulas offers
many possibilities and powerful features. The purpose of this chapter is to
provide you with information about constructing a formula for a Masterplan
worksheet. In addition, we will list and describe all the operators and
functions available.

Formulas can affect either single cells, a network of cells, or large portions
of your worksheet. As you become more comfortable with them, you will
find ways of using formulas in combination with a variety of Masterplan
commands. For instance, The Copy command may prove particularly useful
for extending the power of a single formula because, with it, you can copy a
formula many times over. In addition, the Worksheet and Range Protect and
Unprotect commands offer flexibility by allowing you to protect your
formulas from accidental change.

Defining Formulas

A formula is an instruction for Masterplan to calculate a number (or value).
Formulas may be entered in any cell.

Often you will construct your worksheet using both values and formulas.
Many formula cells depend on value cells because they use the contents of
value cells to obtain results for the formula. For this reason, value cells are
called input cells. The cells containing formulas which reference the input
cells are the output cells.

There are four general rules which apply to formulas:
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1. A formula must begin with one of the following characters: 0, 1, 2, 3, 4,
5,6,7,8,9 .,+ -, (, @, # or §. All characters other than the numerical
ones, the decimal point and $ (which is the absolute symbol) are operators.
The + and - double as operators and as indicators of positive and negative
values.

2. Like values, formulas appear in the control panel on the Edit line as you
type them. [Return] (or any of the methods used for setting values described
in "A Summary of Worksheet Basics") signals that you are finished typing the
formula and that it is to be entered into the cell. While in the Edit mode,
formulas can be easily edited using standard editing functions.

3. A formula may not contain space characters when it is typed.

4. Every formula consists of values and operators and/or @functions.
Depending on the calculation type, when you refer to a value, you can either
type in the numbers for it, use a cell address to indicate that the cell’s
contents are to be used as values, or you may specify a range by name or by
cell address. An operator is a character which defines the operation
performed on the value(s). An @function begins with "@" and a name which
defines its operation.

Typing Characters

Typing the characters which symbolize the values and operations is the
simplest way to set up a calculation. To enter a formula this way, you must
begin it with a formula prefix (one of the seventeen characters listed above)
if it doesn’t already start with one. Then, type in the characters of the first
value, the symbol of the operator, followed by the characters of the next
value and so on in a string until you reach the end of the formula. Do not
use [=] to begin or end a formula. Press [Return] to enter it.

Using Cell References in a Formula
There are two ways in which a value can be entered in a formula by

referencing its cell. You may type the cell address or you may point to it
using the mouse or movement keys. If you include cell references in a
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formula, Masterplan automatically uses the values stored at the referenced
cell whenever it calculates the formula. When there are changes to the
contents of the referenced cells, Masterplan uses the new values and updates
the formulas’ results upon recalculation.

To avoid confusion, we call those cells in which a formula is entered,
formula cells. The cells which are use as references to values in a formula
are called reference cells. In general, these can also be called output cells
(formula cells) and input cells (reference cells).

Typing:

When you type a formula with a cell address, begin by typing a formula
prefix ([+] to indicate positive is the easiest to use), then the first cell address
(column letter followed by row number), and so on. Press [Return] to enter
your formula.

Pointing:

Masterplan is a visually oriented program. This makes it easy to enter a
formula by pointing to the reference cells. You may use your mouse or your
arrow or movement keys.

To construct a formula using the pointing method, first type a formula
prefix (usually [+]), then indicate the reference cell. With the mouse, you can
move the cell pointer to the reference cell and click. Or, you can use your
arrow keys to move the cell indicator to the reference cell. If the cell
reference is at the end of the formula, set the reference and enter the
formula at the same time by pressing [Return]. If another operator follows
your reference in a formula, you may set the reference by typing the
operator in. As soon as you start pointing to a reference cell, Masterplan
places you in the Point mode (see "A Summary of Worksheet Basics"). Type
the next operator (notice that it returns you to the formula cell), and so on to
the end of the formula. Press [Return] to enter the formula.
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Constructing a Formula by Pointing to Cell Addresses
Relative and Absolute Cells:

When you use cell references to build formulas, you are no longer referring
to free standing values. Instead, you are referring to the contents of cells.
Thus, the value used in the formula is the current value contained in the
referenced cell.

In addition, Masterplan recognizes that there may be a relationship or
correlation between the cell which is referenced and the formula cell.
Therefore, unless you specify otherwise, it automatically makes your cell
references "relative".

A relative cell reference uses the distance between the referenced cell and
the formula cell to establish its relationship. The distance is measured in the
number of cells column-wise and row-wise the referenced cell is from the
formula cell. For example, if you have a formula in a cell whose address is
Cl4 referencing cell B13, then the formula is actually taking the current
value of the cell, one cell up and one cell to the left of its location.
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Using Relative References in Cells

If you only use a formula with a relative cell reference in one cell, its
relative nature may not be apparent, However, once you start using the
Move or Copy commands to change the location of the formula cell, the
relationship becomes obvious. For example, if the formula in cell C14 which
referenced cell B13 were moved to D15, then the cell reference would be
changed to C14 because of its relative nature.

Formula cells can also be "absolute". By placing a dollar symbol ($) in front
of the column letter and in front of the row number of the formula cell, you
are letting the program know that the reference cell is absolute and not
relative. When a formula is calculated with one or more absolute cells in it,
no matter where the formula is located, an absolute reference will always
refer to the contents of the cell at the original address. Named ranges can
also be made absolute by putting a "$" before the name. This makes all cell
addresses in the named range absolute when that range is used.

When a formula is written so that one column or row is absolute while the
corresponding row or column of the cell address is relative (or vice versa), it
is called a mixed cell reference. A mixed cell reference can be created by
putting the absolute symbol ($) before the part of the cell address, either
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column letter or row number, you want kept absolute. The corresponding
part of the cell address is left as is (relative). Mixed cell references are often
used with formulas which are copied along rows or columns.
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Using Mixed References in a Formula

By using the Absolute function [Function 4] when you are in the Point
mode, you can run a cell or range reference through a cycle (absolute, mixed,
mixed again, then relative). Point to your cell reference, then use the
function. Each time you use the function it moves your reference one step
further in the cycle.

Revising Formulas

Like other types of entries, formulas can be revised while you are still
typing them or when you are returning to them from another cell.

When you are in the Value mode and are typing a formula for the first
time, you can use the [Backspace], [Function 2] and [Escape] keys to edit a
formula. [Backspace] erases the character preceding the Edit cursor. [Escape]
erases the entire formula you have been entering and returns you to the
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Ready mode. Once in the Ready mode, you can move to another cell or
enter the same cell and retype your formula. [Function 2] places you in the
Edit mode so that you can use the editing commands for major changes.

If you are in the Value mode and decide to point to a cell to use it as a cell
reference, you will be placed in the Point mode. When you are in the Point
mode, there are only two keys which can be used to revise your formula.
The effect of these two keys is different depending on whether you are
pointing to a single cell or a range.

If you are pointing to a cell range, Masterplan uses [Escape] to shrink the
range down to its anchor cell. It changes the anchor cell into just another
single cell. You remain in the Point mode. If you use [Backspace],
Masterplan cancels the previously made range specification and returns the
cell indicator back to the formula cell instead. You are still in the Point
mode.

If you are returning to a formula cell and choose to enter the Edit mode,
you will have more advanced editing features at your disposal. You will be
placed in the Edit mode if Masterplan finds an error in your data when you
enter it. The Edit cursor will be placed at the point of the error. Once in
the Edit mode, you may use all the editing functions available editing other
entries.

Precedence in Calculations

The order in which formulas are calculated often has a bearing on the result
of the calculation. Masterplan uses three factors to govern precedence in
calculation. The three factors are: The order in which a formula is entered
(from left to right), the use of parentheses to determine subgroups which are
isolated and calculated first, and the order of importance of the individual
operators in a calculation.

Order of Entry:

When you enter a formula, you do it from left to right. If Masterplan
doesn’t have any other clue (parentheses or individual operators), it will
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calculate the formula the same way you entered it. For example, if you have
a formula like"6-8+42", it wen’t try to add 2 to 8 before it subtracts the results
from 6. If it did, you would have a final result of -4. The actual result
obtained by the program is 0 because 6-8=-2, then -2+2=0. It doesn’t matter
whether you use freestanding values or cell references. If the individual
operators have equal precedence and you haven’t used parentheses, the
formula will be calculated from left to right.

Using Parentheses to Indicate Subgroups:

When you use parentheses to indicate subgroups in a formula, the section
inside the parentheses will be isolated from the rest of the formula and
calculated first. The results are then integrated back into the formula and
used to calculate it as a whole. If we should decide to include parentheses
around the formula in the example above, we might write the formula like
this: 6-(8+2). In this case Masterplan would first isolate and calculate the
part of the formula enclosed by parentheses (842=10). Then the result would
be integrated back into the formula (6-10=-4).

Precedence of Individual Operators:

Individual operators also affect the way in which a formula is calculated.
There are actually 16 different operators and seven "levels of precedence". A
level of precedence is the amount of priority one operator gets over others.
The table below lists (in order), the operator symbols and their operations.
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Precedence Operator Function

1 2 Exponentiation

2 - Make Negative

2 + Make Positive

3 » Multiplication

3 /. Division

4 + Addition

4 - Subtraction

5 = Equal

S <> Not Equal

3 > Greater Than

3 i Greater Than or Equal

5 < Less Than

5 <= Less Than or Equal

6 #NOT# Logical Not

7 #AND# Logical And

7 #OR# Logical Or

Individual operators and their operations have priority over the order in
which the formula is entered. Whenever possible, Masterplan will try to do
operations in the order of the operators’ precedence. For instance, an
addition operation (which has precedence of four) is done after a
multiplication operation (which has a precedence of three) even if the
addition operation is first in the order of the formula. For example, in the
formula 7+4*10, the result is 47 (4*10=40, then 40+7=47).

Where parentheses are used to set off subgroups, those subgroups are still
calculated first then integrated into the rest of the formula. Using the
example above, 7+4*10, we could enclose the part of the formula we want
done first in parentheses. The formula might now look like this, (7+4)*10.
The result is 110 (because 7+4=11, then 11*10=110).
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Logical Operators:

The logical operators =, >, <, >=, <= and <> are used to compare values.
The result obtained from the use of a logical operator is either 1 (True) or 0
(False). For Example, the formula 1=2 would give the result 0, since 1 does
not equal 2.

Compound Statements:

In addition to the logical operators described above, there are an additional
three which have the precedence level of six (logical not) and seven (logical
and, logical or). These logical operators are also compound statements.
Compound statements are mathematical equations which meet more than one
condition. For example, #NOT# finds all values which are not equal to the
specified value. Therefore, #NOT# finds all values which are not equal to
the specified value.

#NOT# is used to find values which are not specified. For example,
"#NOT#($A$13+2)" finds those values which are not equal to the current
value of cell A13+2.

#AND# is used to find those values which fulfill all conditions set. For
example, "+$A$13#AND#(>5)" finds those values which are equal to the
value of cell A13 and greater than 5.

#OR# is used to find those values which fulfill either one or the other of
conditions set. For example, "+$A$13#OR#$A$15" finds those values which
are equal to either the value of cell A13 or that of cell AlS.

Calculating an Individual Formula

If you would like to know what a formula’s result is without calculating an
entire worksheet, use the Calculation function while you are in the Value or
Edit mode and while the formula is displayed on the Edit line. You may also
use the Calc icon for this purpose. Move the cell pointer over the Calc icon
and click the mouse button or press [Function 9]. Your formula is calculated
and the result is displayed on the Edit line instead of the entire formula.
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Calculations and Masterplan

Calculations and recalculations are performed by Masterplan when you
enter or change a value or formula in a cell. Masterplan performs
calculations in natural order. This means that each cell is calculated by
column, but when it encounters a reference to another cell, the contents of
the reference cell are calculated and the resulting value used to calculate the
formula cell before continuing. Forward references occur when the contents
of one cell hinges on the contents of other cells which haven’t been calculated
yet.

Automatic recalculation after each entry is time consuming, especially if
you are using a large worksheet. At times, you may decide you want to turn
off automatic recalculation and switch to manual recalculation.

First select Manual calculation from the Worksheet Recalc menu (/WRM).
Now you are free to enter data without having to wait for calculation after
each entry. Whenever you make a change in your worksheet, the Calc icon
will appear in the control panel to remind you that recalculation needs to be
done to update results. To recalculate, either click on the Calc icon or press
[Function 9]. To reset recalculations at any time select Automatic from the
Worksheet Recalc menu (/WRA).

Achieving Different Results with Calculations

It is possible to create a worksheet which will not give accurate results.
This can be done in many ways, two of the most common being caused by
circular references and forward references. Just as forward references occur
when a cell refers to the other cells which are generally calculated later in the
sequence, a circular reference occurs when two cells refer to each other. If
you should find yourself recalculating a worksheet with a circular reference,
the Circular Reference icon appears in the control panel.
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Two Special Values: NA and ERR

Two special values, "@NA" and "@ERR", are used to substitute values in
cells with formulas which are impossible to calculate. NA means "not
available". ERR is used when an error has arisen in calculation of the sheet,
such as division by 0, or a reference to a cell in a range which has been
moved. All cells which depend on cells with these values reflect this by
displaying the same type of value. For example, if one cell containing a
value of "ERR" has four cells which depend on it for their values, then all
five cells have the value of "ERR" upon recalculation.

@ Functions

@ functions are built-in formulas. Some, such as @NPV (Net Present
Value), replace what would otherwise be a very complex formula, while
others, such as @SUM, serve as a substitute for a commonly used formula.
@ functions also include logical operations which do not result in numerical
values as such, but instead result in "True" or "False".

@ functions are constructed in a specific way. They begin with the "@"
symbol. This is followed by a function name (such as "sum" or "avg") which
lets Masterplan know what type of function it is expected to do. Although
there are a few special cases, most @ functions are usually concluded with an
argument. The @ functions which do not require an argument are described
as such and listed along with the others at the end of this chapter.

An argument is a set of values which are operated on by the function. The
values you use in an argument can be typed in (free-standing) or cell
references. @ function arguments can consist of single values, a cell range or
set of cell ranges. When they are used, ranges can be referred to by name or
through cell addresses. To find out more about naming ranges, see the
chapter on Range Commands. Depending on the nature of the operation,
some @ functions only accept numbers and will not accept ranges.

As with other formulas, space characters may not be inserted in an @

function. Uppercase and lowercase letters are considered alike when you
type in the function name.
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@ functions can be used by themselves or as part of a larger formula.
Usually, they can be used whenever you need a number for cell entry.

@ function used alone: @sum(A12..A15)
@ function used in a formula: 3+@sum(A12..A15)

@ functions can even be used as parts of other @ functions when they are
set off by parentheses. Extremely complex formulas can be constructed with
@ functions. Should you ever write a formula that is to complex for your
computer to process, it is possible to break down the formula into two or
more parts. Enter them into different cells and use those cell references to
form a simple formula.

Example: In cell Al, put: +A7+@count(A8..A19)
In cell A2, put: +2+3-1+@count(B8..B19)
In cell A3, put: +Al+A2

@ Function Types

As we mentioned earlier, There are several different types of @ functions.
We have grouped the @ functions in the order of their various types for
further discussion. The groups are: financial, logical, mathematical,
statistical, special and date functions.

FINANCIAL FUNCTIONS

The financial functions are used to find values of calculations which are
purely financial in nature. For example, you would use these functions to
find the future value of an annuity or to find the present value of an
ordinary annuity.

@lRR (best possible guess, cash payment series):

The Internal Rate of Return function finds the (approximate) internal rate of
return for a series of cash payments made at set intervals. This function
requires a value which represents your best possible guess at the right answer.
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It also requites a series of cash flows (one negative and the rest positive). No
blank cells should be included in the series. Should there be any period when
no cash payment was made, place a zero in its cell.

This function uses an iterative scheme to find the correct answer. If a
convergence to within .0000001 doesn’t occur within 20 iterations, the result
of the value is "ERR". At times, depending on what best possible guess you
first make, the result of the function may vary when you use the same cash
payment series. Usually, if a guess is between 0.0 and 1.0, it will yield an
accurate result.

Example:
[A] [B] 61 4P} %) . (R}

1 Pmt. -2500 1250 1000 500 250
[2] Guess 0.12

@IRR(B2,B1..F1)=0.102212

@NPV (interest rate, series of future cash flows):

The Net Present Value function is used to find the net present value of a
series of future cash flows. The initial payment is a single value. It is
entered as a positive value. The interest rate is also a single value. It is a
percentage which represents the rate of interest for each period. The series
of future cash flows is a range representing receipts of payments stemming
from the initial value. The range which represents the series of future cash
flows must be a single column or row. Blank cells should not be used, but
Zeros may represent areas of non-receipt.

The actual result of the function includes the initial payment. To find the
overall net present value, subtract the initial payment from the result.
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Example:
(A1 8] Q. [P (8

1 Initial 1000 Rate 11%

[2]
[3]  Series 500 500 500 500

+B1+@NPV(E1,B3..E3)=2551.222

@FV (payment, interest,terms):

The Future Value function is used to find the future value of an annuity.
For this you need to specify a monthly payment value, an interest rate (per
period) and a number of payment periods. You may use numbers or cell
references as values.

Example: If Payment =1200, Interest=6% and Terms=12, then
@FV(1200,.06,12)=20243.92

@PV (payment, interest, terms):

The Present Value function is used to find the present value of an ordinary
annuity. It needs a payment, an interest rate and a number of payment
periods. You may use numbers or cell references for values.

Example: If Payment=1200, Interest=6% and Terms=12, then
@PV(1200,.06,12)=10060.61

@PMT (principal, interest, terms):

The Payment function is used to calculate mortgage payments based on
principal, interest rate and the number of periods. Even if you use zero as
an interest rate, the function will yield correct results. You may use numbers
or cell references for values.

Example: If Principal=1000, Interest=6% and Terms=12, then
@PMT(1000,.06,12)=119.2770
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LOGICAL FUNCTIONS

The logical functions are very like the logical operators discussed earlier.
Logical functions are used to test other values and formulas or just to
represent the values of true or false. @True and @False do not take
arguments.

@FALSE:
The False function represents the value of 0 (false).
Example: @FALSE=0

Therefore: @False*8=0
@ TRUE:
The True function represents the value of 1 (true).
Example: @TRUE=1

Therefore: @TRUE+(5*2)=11
@lSNA (value):
This function represents the value of 1 (true) if the specified value has the
value NA (not available). If not, it has the value of 0 (false).
Example: If cell A2 has the value, NA, then @ISNA(A2)=1

@ISERR (value):

This function represents the value of 1 (true) if the specified value has the
value ERR (that is, if the value has an undefinable result). If not, it has the
value of 0 (false).

Example: If the value of cell A5 is 5, then @ISERR(A5)=0
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@IF (condition, first value, second value):
This function is used to first test the condition. It then uses the first value if
the condition is true. It uses the second value if the condition is false.

Example: If the value of cell B2 is 7 and the value of cell B3
is 8, then @IF(B2>B3,2,5)=5

MATHEMATICAL FUNCTIONS

The mathematical functions cover many different areas of pure
mathematics, including many trigonometrical and algebraic expressions. We
have listed the trigonometrical functions first. Of these functions, @PI and
@RAND do not require arguments.

@ACOS (cosine of the angle in radians):

This function calculates the arc cosine from the cosine of an angle in radians.
The cosine value must be between -1 and +1. It can be entered as a number
or a cell reference. The result of the function is always between 0 and Pi. If
not, it is indicated by the value "ERR".

Example: @ACO0S(.3)=1.266103

@ASIN (the sine of the angle in radians):

This function calculates the arc sine from the sine of an angle in radians.
The sine value must be between -1 and +1. It can be entered as a number or
a cell reference. The function’s result is always between -Pi/2 and +Pi/2. If
not, it is indicated by the value "ERR".

Example: @ASIN(.5)=0.523598
@ATAN (tangent of the angle in radians):
This function calculates the arc tangent from the tangent of an “angle in

radians. The function’s result will always be between -Pi/2 and +Pi/2.

Example: @ATAN(1)=0.785398
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@ATAN2 (first value, second value):

This function calculates the arc tangent from the tangent of an angle in
radians. The tangent is represented as y/x. If the first value is zero and the
second value is zero, the result is displayed as "ERR". It is entered
differently than @TAN (second value, first value) because it considers the
signs of the first value and the second value to have separate values for all
four quadrants, from -Pi to +Pi.

Example: @ATAN2(.5,1)=1.107148

@COS (angle in radians):

This function calculates the cosine of an angle in radians.

Example: @C0s(.5)=0.877582

@Pl:
It is frequently used to convert degrees to radians. One degree equals
@PI1/180 (radians). This function does not require an argument.

Example: 20*(@P1/2)=31.41592

@SIN (angle in radians):

This function calculates the sine of an angle in radians.

Example: @SIN(1.5)=0.997494

@TAN (angle in radians):

This function calculates of the tangent of an angle in radians. The value
"ERR" is displayed if Angle-In-Radians equals Pi/2+Pi*n (n being any
integer).

Example: @TAN(1.5)=14.10141
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@ABS (value):

This function calculates the absolute value of a number.

Example: If the formula in cell Al reads 6-8, then @ABS(A1)=2

@EXP (value):
This function calculates a value raised to the exponential power. If the value
is greater than 230, the result is displayed as "ERR".

Example: @EXP(10)=22026.46

@INT (value):

This function finds the integer part of a value.

Example: If a formula is cell Al reads 3-.6, then @INT(A1)=2

@LN (value):

This function calculates the natural logarithm (or base e of the value’s

logarithm) of the value. The result is displayed as "ERR" if the value is zero
or negative.

Example: @LN(10)=2.302585

@LOG (value):

This function calculates the base 10 logarithm of the value. The result "ERR"
is displayed if the value is zero or negative.

Example: @L0OG(5)=0.698970

@MOD (first value, second value):

This function finds the value of the remainder from the first value after it

has been divided by the second value.

Example: @M0D(30,4)=2
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@RAND:

This function is used to find a random number which is distributed
uniformly between 0.0 and 1.0. It doesn’t use an argument.

Example: @RAND=0.414100 or @RAND=0.690568

@ROUND (value, number of decimal places):
This function is used to round off a value to a specified number of decimal
places.

Example: If the formula in cell F2 reads 2.34*2.456, then
@ROUND(F2,2)=5.75

@SQRT (value):

This function calculates the square root of a value. If the value is negative,
the result of this function is displayed as "ERR".

Example: @sQRT(169)=13

STATISTICAL FUNCTIONS

The statistical functions require a list of values to work with. The list
specified can be a range.

@COUNT (ist):

This function counts all the items in a list and uses that number as its value.
If the list consists of one cell, the result will always be "1" even if the cell is
blank. In all other cases, blank cells are not counted.

Example: @COUNT(2,4,6,8)=4
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@SUM (list):
This function adds all the cell values of the list. If the list is a range, blank
cells are ignored.

Example: @suM(2,4,6,8)=20

@AVG (list):
This function averages all the values of the list. If the list is a range which
contains empty cells, they are ignored.

Example: @AVG(2,4,6,8)=5

@MIN (list):
This function finds the minimum value of the list. If the list is a range,
empty cells are ignored.

Example: @MIN(2,4,6,8)=2

@MAX (list):

This function finds the maximun value of the list. If the list is a range,
empty cells are ignored.

Example: @MAX(2,4,6,8)=8

@STD (list):

This function gives the standard deviation of the values in the list. Blank

cells in a range are ignored. If the list is empty, the result is "ERR".

Example: @sSTD(2,4,6,8)=2.236067
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@VAR (ist):
This function gives the variance of the values in the list. Blank cells in a
range are ignored. If the list is empty, the result is "ERR".

Example: @VAR(2,4,6,8)=5

SPECIAL FUNCTIONS

Special functions do not relate to any particular subject. Instead they are a
special set of functions which help you define or find values on your
worksheet. You have already been introduced to two of them: @NA and
@ERR.

@NA:
This function indicates that a value is not available. The result is displayed
as "NA".

Example: @IF(3>2,@NA,3)=@NA

@ERR:

This function indicates that a value cannot be defined. The result is
displayed as "ERR".

Example: @IF(3<2,3,@ERR)=@ERR

@CHOOSE (x,set of values):

This function is used to test logical expressions or to look up short tables.
The first value of the argument (x) is converted to an integer. The rest of
the argument is a list of optimal values. This first value of the argument
must be greater than or equal to 0 and less than the largest of the values in
the list. If not, the value of this function is displayed as "ERR". Otherwise,
the result is a value from the list of values whose order corresponds with that
of the integer plus one.

Example: @CHOOSE(3,2,5,4,6,8)=6
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@HLOOKUP (x, range, offset):

This function looks up a table horizontally if "x", the test value, is in the first
row of the range. X specifies the column in which the result can be found.
The range you specify consists of the area which is to be searched (usually
the entire table). In the first row of the range, values cannot be duplicated
and must be in ascending order. If the first value exceeds x, then the result
is displayed as "ERR". For any other value of the row which exceeds x, the
result is the value of the cell below the previous value in the row. The offset
determines how many rows below the first one in the range it should look to
find the result of the function.

Example:
[A] [B] [C] [D]
[1] 1 2 3 4
[2] 5 10 15 20
3] 25 4.5 6.5 8.5
@HLOOKUP(3,A1..D3,1)=15
@VLOOKUP (x,range, offset):
This function is similar to the one described above, except that the look-up is
done on a vertical basis, so the range is based on the first column.

Example:

(Al [B] [C]

TR 5 2.5
0y g 10 45
18] 13 15 65
4] 54 W ax

@VLOOKUP(2,A1..C4,1)=10
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DATE FUNCTIONS

Masterplan provides a sophisticated, yet easy to use method for including
dates in calculations and for creating calendars. The trick to it is the
conversion of calendar dates (from January 1, 1900 to December 31, 2099)
into numbers starting at 1, and increasing by one for every day since. This
takes into consideration the February months and leap years. Every date has
a specific number that can be attached to it, such as the number 36526 for
January 1, 2000. Once you have the dates numbered, you can add a month
or a year by adding 30 or 365 to the number for the date, as well as
performing many other calculations.

Obviously, to do this easily, you need functions to find the numbers (or
serial dates). You will also need functions to turn these numbers back to
calendar dates. These functions are provided by the date @ functions and by
the Worksheet and Range Format Date commands.

The first two functions listed below allow you to change today’s date or
another specified date into its serial version so it can be used in calculations.
A Date Format command can be used to convert the calculation’s result back
into calendar format.

@DATE (year, month, day):

This function calculates the serial number of a date. The year used must be
between 1900 and 2099. When you use a date as an argument, enter it in
parentheses, and numerically: Year, Month, Day. Years are numbered from 0
to 199 and start at 1900. For example, you might use "@DATE(83,4,12)" to
to change the date April 4, 1983 into its serial number. If you enter it in the
wrong order, Masterplan will still evaluate it. If it is an impossible date,
"ERR" is displayed in the cell. By an impossible date, we mean one which
has too many months in the month’s places or too many days for the
specified month. For example, the dates entered as "(85,14,12)" and
"(85,2,30)" are impossible dates. There are not 14 months in a year, nor are
there 30 days in February.

Example: @DATE(85,9,24)=31314
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@TODAY:

This function is used to change today’s date to its serial date (up to December
31, 2099). This command is only effective if you have set the date using
GEM'’s Control Panel in the Desk Menu.

Example: If you entered today’s date as Sept. 24, 1985, then
@TODAY=31314

The following three date @ functions convert a serial number into the
actual day, month or year, in numbers. These functions are useful for
finding out where you are in a series.

@DAY (date):

This function finds the day of a month given the serial date (which is used
between January 1, 1900 and December 31, 2099).

Example: @DAY(31314)=24

@MONTH (date):

This function is used to find the month number from a given serial date
(from January 1, 1900 to December 31, 2099).

Example: @MONTH(31314)=9

@YEAR (date):

This function is used to find the year number from a given serial date (from

January 1, 1900 to December 31, 2099).

Example: @YEAR(31314)=85

Using Date @ Functions to Calculate Dates

As was said above, date @ functions let us work easily with dates in
calculations. With date arithmetic, we can take calendar dates translated to
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their serial dates with the @DATE or @TODAY functions and add days,
months or years to create time periods for whatever purpose. We can also
create complex formulas with logical expressions for special calculations.

The way the calculation results are changed back into calendar dates is
through the date format commands in the Worksheet and Range menus. The
date format commands take a number and change it into the corresponding
calendar date, with three optional displays: Day-Month-Year (i.e. 07-MAR-
85), Day-Month (i.e. 07-MAR) and Month-Year (i.e. MAR-85).

For example, the date, March 28, 1985, is displayed as 31134 when entered
in a cell with the date function @DATE(85,3,28). This number can be
changed back into the display of a calendar date 28-MAR-85 by selecting the
Date option (Day-Month-Year) of the Range Format command for that cell.

Example: Starting from the date, Sept, 24, 1985, if you want to
find out if 61 days (or two months) later is
November 24, 1985:

1. First make sure an empty cell has a date format (if not, use
the Range Format command) and that its column width is wide
enough to display the result of the function (12 spaces).

2. Enter the formula:
@IF((@DATE(85,9,24)+61=@DATE(85,11,24)),@DATE(85,11,24),@ERR)
Press [Return].

3, If the date 61 days later is November 24, 1985, then that date
will be displayed in the cell. If it is not, "ERR" will be
displayed instead.

A good example of the usefulness of date arithmetic is the creation of a
column of months in the year for expenses, such as that in the following
example. Instead of entry of labels for all the months, we could use date
arithmetic to increment the last date by 30 days to go through the sequence
of months from January through December. The first step would be to use
the @DATE function in cell A4 to find the serial number for a day in
January of 1985, say January 6: @DATE(85,1,6). The next step would be to
go to cell A5 and enter the formula +A4+30 to add 30 days to the previous
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month (30 days is a bankers month). Next, copy the contents of cell A5 from
A6 to A15. This serves to add 30 days to the date of the previous cell. The
final step would be to format the cells from A4 through A15 with the Range
Format Date Month-Year command. Now you would have a nice succession
of the months.

Desk File Edit Morksheet Range Graph

4 =1 0K [Cancel| Calc [Edit[6Graph| READY | |
L@

2 R2: (D3) GDATE(87,1,6)
.| i ;

o ..2321,88 | 5185,88 . 234,80
& Feb-87 324,21 @ 5186.85 2 325:22
4 Mar- 327.45 @ 5188.7
3 Apr-87  9338,73 ' 51386
6 May-87 @ 5334,83 92,
Jun- 7,37 94,44
8 Jul-87 @ 5348,75 = 9136.38
9 Rug-87 44,16 98.35
.18 Sep-87 47.60 | 9268,
Oct-87 | 9351.87 02,
Nov- 354,38 | 9284,36 | 9231,
Dec- 358,13 . 206,48 .

>

Using Date Arithmetic to Create a Monthly Breakdown
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INTRODUCING MENUS

Using Menus to Select Commands

Many Masterplan commands can be reached through menus. Menus are
lists of choices which pertain to one subject. The lists are called menus
because of their similarities to the menus you use in restaurants. The choices
listed on a menu are called items or commands.

The commands of Masterplan are structured in layers, with subsidiary
menus stemming from one dominant menu. From these subsidiary menus
stem other menus. One good way to look at the command structure is to
think of it as a tree. The Main menu items are like branches, their submenus
are like twigs and further submenus are like leaves.

You use this menu structure when you issue commands. For example, to
choose the Worksheet Format Date command, you must type /WFD if you are
in the main menu. This moves you from the main menu to the Worksheet
menu (/W), then from the Worksheet menu to the Format menu (F) and
finally specifies the Date command (D). If you are already in the Worksheet
menu or the Format menu, you don’t move through those menus to get to the
command.. Typing FD (if you are in the Worksheet menu) or D (if you are
in the Format menu) is sufficient.

The same concept holds true with the modes you use. If you are working
from the keyboard, you do not press [/] unless you are in the Ready mode.
If you are already in the Menu mode and press [/], it has no effect. Of
course, this does not apply when you are using a mouse because Masterplan
automatically moves you from the Ready to the Menu mode and you don’t
need to press [/].

We have organized our discussion of menu related commands into several
chapters. This chapter introduces menu commands and gives you some
necessary information about them such as issuing the commands and
canceling wrong choices. The remaining chapters deal specifically with one
of the items which governs an aspect of Masterplan.
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Invoking a Command by Pointing

There are two ways in which a command can be invoked by (or issued).
One way is by pointing to it on a menu.

Using a Mouse

If you are using a mouse, move the cell pointer to the menu line. You can
move the pointer over the items listed, highlighting each item in turn. As
you highlight items, their drop-down menus appear in columns below them.
You can move up and down through these menus. Each item is highlighted
as you pass over it. To make a selection, highlight one of the items from the
menu and click the left mouse button.

If you don’t want to make a selection, just click the mouse button while the
pointer is outside the drop-down menu. If you accidentally choose a
command, place the cell pointer over the word "Menu" in the mode indicator
and click the mouse button. This is the mouse equivalent to a Break. The
mouse equivalent of [Escape] is the Cancel icon. Move the pointer over the
icon and click the mouse button for each time you want to use [Escape].
[Escape] moves you one step back in your current command series.

Using the Arrow Keys

To point to an item from a menu, first press [/]. The program highlights
"File" on the menu line. By using [Right] and [Left], you can move back and
forth along the row, highlighting each item in turn. If you press [Return]
while a command is highlighted, a new menu of sub-commands appears on
the menu line. Alternatively, you may be faced with a series of prompts
which lead you through a command process.

If you don’t want to make any of the selections, simply press [Escape] until
you return to the Ready mode or issue a Break by pressing [Control][Undo].
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Invoking a Command by Typing Command Letters

Another way to issue a command is by using the keyboard to type it.
Precede a command or series of commands with a [/]. This lets Masterplan
know that the letters you are about to type belong to a command and are not
to be entered into a cell.

Now, you can begin to type in the command of your choice. Masterplan
recognizes the command by the initial letters and moves on to the next step
of the command. For example, if you choose to change the Worksheet
Format to Currency, type /WFC (the first letter of each of the commands).
The slash begins the command sequence. W chooses the Worksheet item from
the main menu. F chooses the Format item from the Worksheet menu. Then
C chooses Currency from the Format menu. You are then asked to enter the
number of places after the decimal point. Enter the number or press
[Return] to accept 2 places, the default.

If you make a mistake typing in command letters, you can use [Escape] to
back up one step at a time in your command sequence. For instance, if you
type in /WFD but you really want /WFC instead, press [Escape] to take you
back one step and then press C for Currency. On the other hand, if you
want to escape from the entire sequence, use a Break ([Control][Undo]) to go
directly to the Ready mode.

The Menu Mode

When you are selecting menu commands, the mode indicator displays the
word "Menu". While you are in this mode, you cannot move freely about the
worksheet or enter data. Once you have finished a command series or
escaped, the mode indicator changes back to Ready and you can move about
the worksheet or invoke another command.

Masterplan’s Messages and Default Entries & Prompts
Masterplan helps you move from step to step in many commands by issuing

prompts. Some examples of what you may be prompted for are file names,
range names or other needed information. These can be specified by typing
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in the answer you want and pressing [Return] or, when appropriate, by using
the arrow keys or mouse to point to a name on a list and pressing [Return].

Error Messages

Error prompts may also be used to inform you when an error has been
made. Masterplan uses prompts instead of just beeping at you when there is
an error because it tries to give you as much information as possible about
the error so you can solve it easily.

When a minor error is made, like trying to move off the worksheet with the
arrow keys, the computer will merely beep at you. It assumes that you are
aware of the cause of the error. At other times, Masterplan moves you to the
source of the error in addition to beeping at you. With many of the more
sophisticated commands and functions, errors are more difficult to pinpoint.
In such cases, Masterplan displays an error message on the screen until you
click Cancel.

Default Entries

Masterplan may also present you with a default entry. A default entry is
an entry which appears automatically on the screen in response to a prompt.
Default entries are based on the premise that it is easier to accept or revise
an existing entry than it is to type a new one. In dealing with a default
entry you can do one of three things: accept it, revise it or exchange it for
one of your choice.

If you accept an entry as it stands press [Return]

If you want to revise the entry, you can do so while you are still in the
Edit mode by using your movement, delete and backspace keys. Characters
can also be inserted by typing them in where they belong. You will find that
there are a few exceptions in which an entry cannot be revised but must be
either accepted as is or completely retyped.

70




Masterplan Introducing Menus

If you would rather type in a new entry, press [Escape] once to erase the
existing entry and type in the new entry.

Correcting Typing Mistakes

When you type a command, Masterplan places you in the Edit mode until
you are finished. You can correct any typing errors you make while you are
in the Edit mode by using the features made available to you by that mode.
This feature is particularly useful when you need to type in a new range
name.

Once You've Issued a Command

Masterplan usually returns to the Ready mode after the command or
command series has been executed. You can then enter another command or
start entering data in your worksheet. However, this like all other rules, has
its exceptions.

There are times when Masterplan anticipates that you will be issuing several
menu commands in succession. The menu of related commands will stay on
the screen until the program feels that you have issued all the necessary
commands.

For example, you may choose Graph from the main menu (/G). Then
choose and execute the Type Bar (TB) to select a bar graph. Notice that
after you make the Bar selection, the program redisplays the main Graph
menu. You can either make another selection or select Quit (Q) to return to
the Ready mode.

When Masterplan anticipates that you may be invoking several related
commands in a row, it often offers the Quit command with the other menu
selections. Then if you want to get back to the Ready mode without making
all the selections offered to you, you can select Quit (Q). You may even be
able to use Quit several times before you are returned to the Ready mode.
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Escaping from a Wrong Command

Sometimes, you will find that you have issued a wrong command or you
might decide that you really don’t want to have a command executed even
though you have already invoked it. If you haven’t executed the command
yet, you can cancel the command by pressing [Escape]. [Escape] backs you
up one command step in the present series each time you press it.

If you are using a mouse, you have the equivalent to pressing [Escape]. By
moving the mouse over the Cancel icon and clicking the mouse button once,
you can cancel the command you just issued. If you click the mouse button
more than once, each time you do, Masterplan will move one step back in the
command sequence.

A fast way to undo a whole series of commands is to use a Break. The
Key combination used for a Break is [Control] [Undo]. The mouse equivalent
is to click the mouse button while the pointer is over the mode indicator. A
Break will undo all the commands issued in the present series. You will be
returned to your last position in the Ready mode.

But how can a command that has been executed be undone? This is harder.
In some cases you can use the Undo command in the Edit menu (/EU)}. In
other cases, you will find there is a Reset command which allows you to
cancel settings you made using other commands. Usually, the only way to
undo a command which has already been executed is by issuing another
command which voids the first one. If you insert an unnecessary row in
your worksheet, you will have to issue a command to delete that row.

72




Masterplan File Commands

FILE COMMANDS

Introduction

[BEEdit Worksheet Range Graph
1{Calc [Edit|Graph READY

UNTITLED |
D

The File Menu

File commands are used to store, retrieve, print and erase your worksheets.
They are also used to interact between the different stored areas so that you
can do such things as combining and extracting parts of files.

The files of Masterplan are similar to files used in an office. Each file
stores a different subject and needs to be pulled out (or opened) once it has
been filed (or saved) if you want to look at it again. Instead of saving the
files in a cabinet, you will be saving the files on formatted data disks.

The contents of your files, worksheets and soft copy for printing, are
created in your computer’s memory. However, the files themselves are stored
on data disks. Every time you open a file, you are actually copying all the
information in the file on that disk back into your computer’s memory so
that you can work with it.
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With Masterplan, you only work on one worksheet at a time. When you are
finished working on it or when you want to turn the computer off, you need
to save your work to a disk. The number of files you can save to one disk is
limited by the amount of memory available on the disk. But since you can
use as many data disks as you want, the total number of files you save is
virtually unlimited. Files are also grouped into folders or, as they are called,
directories. Each folder may be used to contain several files pertaining to
one particular subject. The disk drive and directory is initially the same
folder you loaded Masterplan‘from. You can also specify a different folder
from the File Selector Box.

When an error is made while opening or saving files, Masterplan will
display an error Dialog Box if it has problems reading from or writing to
your disk. This means that, somehow, information is not being passed
correctly to and from the computer.

Each file must be stored under its own file name. Then, when the
computer is asked to open a file, it can find the right one from all the files
you have in the folder. No two files in a folder can have the same name. If
you try to give the same name twice, Masterplan "overwrites" the first file
with the second file. Overwriting occurs when the contents of the first file
are erased and replaced with the contents of the second file. If you attempt
to overwrite a file, Masterplan will display a Dialog Box asking you to
confirm or cancel, before it overwrites your file.

Even though you can save two files with the same name to different disks,
it is not advisable. Similarly, named files can cause confusion when you try
to remember what their contents are.

Worksheet file names can be up to eight characters long. The characters
you may use are the same as those for GEM. If you use characters from the
alphabet, Masterplan recognizes upper and lowercase as being alike.

Example: "ACCTS3" is acceptable as a file name. "ACCOUNTING" is not

acceptable because it is too long. "ACCTS 3" is also not acceptable because
file names may not contain space characters.
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File Save

The File Save command is used to save a worksheet and all its settings from
the computer to a disk. The File Selector Box is pictured below.

Desk File Edit Worksheet Range 6raph
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i ]
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The File Selector Box

To use File Save, first select the Save command from the File menu (/FS).
Type the file name you wish to use or select an existing file name which
appears in the File Selector and press [Return] or click OK. If you select an
already existing file name, Masterplan will ask you to confirm or cancel
overwriting the existing file. If you decide that you'd rather keep the older
version, select Cancel. To save the file select OK. The file will be saved
with the name you specified along with the extension, ".WKS". All worksheet
files are saved with the ".WKS" file extension.

If there is not enough space available on your disk to store the file,
Masterplan will tell you that the disk is full. In this case simply insert
another formatted data disk and repeat the File Save command.

In rare cases, you may want to save a worksheet which has more

information than can be stored on a data disk. If this happens, separate the
information by using the File Xtract command (discussed later in this
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chapter) and place the information on different disks. To retrieve the
information, use the File Combine command (also discussed in this chapter).

File Open

The File Open command is used to move information from a file stored on
a disk to the computer’s memory. Masterplan will only search for the file in
the current folder with the file extension ".WKS". You can select a different
folder by clicking on a folder displayed in the File Selector Box.

If you are working on a worksheet, make sure you save it before you open
another or you will lose it. Masterplan automatically erases whatever is in
memory before it opens a new file for you.

To use the File Open command, first select Open from the File menu
(/FO). Indicate which file you want opened by typing in the name or
selecting it from the list of ".WKS" files displayed in the File Selector. Press
[Return] or select OK to open the file. Select Cancel to return to the Ready
mode.

File Combine

The File Combine command is used to add part or all of a saved worksheet
to the worksheet you are currently working on. The Combine command does
not erase the worksheet you are using and only affects the areas both
worksheets have in common. The worksheets are matched cell for cell and it
is only those cells which have the same coordinates, or cell addresses, which
are used. How the current worksheet is affected by File Combine depends
on one of three options you select when you issue the command.

The first option you have is to copy entries from the saved worksheet to
the current worksheet. When you select the Copy option, each entry from
the area of the saved worksheet replaces the matching entry of the current
worksheet.
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Copying Worksheet Cell Contents with File Combine

Another option is Add. Entries from the saved worksheet which match the
position of those from the current worksheet are added to those from the
current worksheet. Only numbers and formula values from the saved
worksheet are used during the File Combine command. Labels and empty
cells from the saved worksheet are ignored. Empty cells from the current
worksheet take the added values of the saved worksheet’s cells.

The last option, Subtract, is similar to adding. The only difference lies in
the operation. Numbers and formula values from the saved worksheet are
subtracted, not added, to the current worksheet.

To use the File Combine command, place the cell pointer at the upper left
corner of the area in your current worksheet where you want to combine the
file. Select the Combine command from the File menu (/FC). Now, select a
method of combining. Select Copy (C), Add (A) or Subtract (S). Select the
entire saved worksheet (E) or a named range (N). If you selected a named
range, type the name of the range. If you selected the entire file, specify the
name of the worksheet by typing it or selecting it from the names displayed
in the File Selector Box. Press [Return] or click OK to combine worksheets.
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Note: When you combine a file with your current worksheet, any range
names in the file being combined are not added to the list of names in your
current worksheet.

It might be a good idea to save the current worksheet and to make a copy
of the saved worksheet before you use this command if you don’t have much
experience with this command or are unsure of what its effect might be.
This way you will still have a copy of your work. The File Combine
command cannot be rescinded once it is invoked.

File Xtract

The file Xtract command is used to save a range or, as an option, to save
currently displayed formula values (rather than the formulas themselves) of a
range from a worksheet into a separate worksheet file. The command is
often used to save part of a worksheet or, when used with the File Combine
command (discussed previously), to save part of one worksheet to another
worksheet file.

To use the File Xtract command, select the Xtract command from the File
menu (/FX). Select save formulas (F) or only the current values of formulas
(V). Now select a file name for the extracted portion of your worksheet. If
you select a file name already in existence or the file name of the current
worksheet, Masterplan will ask you to confirm that you want to overwrite the
existing file or cancel the command. Click OK to Xtract the portion from
your worksheet, then specify the range to be extracted with the mouse or
arrow keys. Press [Return] or click OK to confirm the range and a new
worksheet file containing the extracted range is saved with the name you
specified. All settings which are a part of that section are also saved.

File Import

The File Import command is used to copy numbers and/or labels from a
file which wasn’t created by Masterplan, to a worksheet. With this command,
you can import just text or numbers and labels and superimpose this new
data at a specified spot in your worksheet. Domestic equivalents to the File
Import command would be the File Open and File Combine commands.
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The File Import command processes most standard format print files from
programs other than Masterplan. Standard format files are files which do not
use characters or formats which are peculiar to the word processor or
computer they were created on. This includes ASCII files created by most
Atari ST programs. Most standard format files which can be displayed using
the "Show" option from the GEM Desktop, can be imported.

After making sure that the file you want to import is appropriate, you can
use the File Import command. First position the cell indicator over the upper
left hand cell of the worksheet area you want to use. Select the Import
command from the File menu (/FI). Decide whether you want to specify
Text (T) or Numbers (N). If you decide on numbers, you must enclose all
the labels of the imported file in quotation marks. This can be done using
the source program or a text editor. Then, type the name of the print file to
be imported. Press [Return] or click OK.

With text, Masterplan changes each line of text into a long label, moving
down line by line. A paragraph is really a series of long labels, all starting in
the same column. The labels are begun at the spot specified by the position
of the cell indicator. The length of each label depends on the length of each
line of the imported text. Each cell of the worksheet can contain as many as
240 characters (although only those which fit in the worksheet will be
displayed).

With numbers, Masterplan searches out all numerical values and sets of
characters (labels) enclosed by quotes. These numbers and characters are
transferred to the worksheet line by line. The worksheet matches the print
file’s lines with its rows. The numbers and labels are entered successively;
with each number/label following the last one a cell to the right. The labels
enclosed by quotes are transferred to the worksheet as left aligned labels.

With the File Import command, the imported data replaces worksheet cell
contents in the area in which it is entered. However, if there are blank lines
in the imported print file, the worksheet moves its contents down a matching
number of rows from the place the blank lines are inserted.

79




Ditek International Masterplan

It is important to make sure that when you import text, it has been
standardized. With Masterplan, you could still try to import non-standard
text, but the results are unpredictable and can be quite surprising.

File Erase

The File Erase command is used to delete a file or files from a disk. It is
most often used to remove files one at a time from a disk so there is more
room for storage on the disk. Care must be taken when using this command
because once a file has been erased, it cannot be recovered.

To use the File Erase command, first select the Erase command from the
File menu (/FE). Indicate the file to be deleted by typing its name or by
pointing to it in the File Selector Box. Click OK or press [Return] to erase
the file specified. Click Cancel to return to the File menu.

You can also use GEM’s Wild Card characters when specifying a file name
if you want to erase more than one file at a time such as "*.*", "¥ extension"
or "filename.*". See your Atari ST Owner’s Manual for more details.

File New

The File New command is used to clear all the information entered in your
worksheet. This command should only be used if you feel that the work you
did during the session is unusable.

Any information stored in your worksheet is cleared. All individual and
worksheet settings are returned to their initial values.

To issue the New command, Select it from the File menu {/FN).
Masterplan will require that you confirm this command. Select Cancel to
return to the Ready mode. Select OK to clear all the information and
settings you have added to your worksheet since it was first loaded. All
settings are returned to their initial settings.
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File Quit

When you are ready to quit your worksheet, Masterplan has a special Quit
command. To use the Quit command, select Quit from the File menu (/FQ)
or click on the Quit box at the left side of the Title bar. Masterplan requires
that you confirm this command. After selecting Quit, click on OK if you
have saved your work and want to return to the Desktop. Select Cancel to
return to the Ready mode.

Masterplan requires that you confirm the Quit command to give you a
chance to save your worksheet if you wish to do so. If you wish to retain
your work in some form, use the File Save command to save your entire
worksheet, the File Xtract command to save a portion of your work or the
print commands to print your worksheet now or save it to a print file.
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THE FILE PRINT COMMANDS

Introduction

Masterplan uses Print commands to prepare a printed version of a
worksheet. The Print commands are used only to print worksheets. Before
you print your worksheet, you must make sure your printer is properly set
up. Setting up your printer is controlled by the Install Printer selection from
the Desktop. If you have problems, consult your Atari ST Owner’s Manual.
Print commands are not used to print graphs. Graphs are printed from the
Graph menu (see The Graph Commands).

Print commands allow you to obtain a printed version of your entire
worksheet or only a part of it. The printed versions are known as "hard
copy". Print commands also allow you to save your prepared copy for
merging with another document using a text editor. If you decide to save
your print-ready copy, Masterplan saves your work in a print file. The
contents of a print file look exactly like the hard copy version (complete with
margin, etc.). This electronic version of a printout is known as "soft copy".

Printing Now Versus Saving to a Print File

The first choice you will have to make when you select Print is whether to
print your work directly or to store it as a print file. You will make this
choice by selecting File Print Printer (/FPP) if you want to print your work
during this work session or by selecting File Print File (/FPF) if you want to
save it to a print file.

When you select Printer, you will be allowed to choose all the Print options
you need to prepare your worksheet for printing. Then, when you choose the
Go command, the worksheet (or range) with settings and other Print
command specifications are passed directly from the computer to the printer.
A hardcopy of the range you selected is made. With the Go command, you
also have several other commands (such as Align) which help with the
positioning of the paper in the printer.
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As the first step of the Print File procedure, you will be asked to select a
name for your file. Naming files is described in the "File Menu" chapter.
Your newly chosen file will have the ".prn" extension added to it
automatically. When you select the Go command, your prepared copy will be
stored on the disk in a print file. Such commands as Align which help with
the positioning of paper in the printer are not necessary at this point.

A popular use of the Print File command is to create files which can be
used in a word processor. The Print File command allows you to save a text
version of your entire worksheet or just a portion of it. You can load it into
a text processor for letters or reports.

Print Range
Worksheet

How a Worksheet is Printed
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The Print Commands

Once you have chosen whether to save your work in a file or to print it,
you will be placed in the main Print menu. The main Print menu appears at
the top of the screen. It consists of these commands: Range, Line, Page,
Options, Clear, Align, Go and Quit. Of these commands, Quit will take you
out of the Print menu after a printing session. Range and Go are the only
mandatory commands for printing. All other commands are optional.

Now that you are in the Print menu, the first thing that you’ll want to
think about is how much of your worksheet you want to print and what it
will look like. For one printing, or print file, you may use one or more
ranges from a worksheet or the entire worksheet. If you want to print the
whole worksheet, that will be your range. If it’s a series of smaller ranges
you want printed, you will have to specify each range of the series
separately.

The worksheet or range(s) you decide on will become the object of the
other print commands. You can decide such things as what margins to use or
if you want your copy to include headers and footers. In addition, you can
decide whether to print your work as it is displayed or cell by cell, with
underlying cell formulas instead of current values. After you’ve decided all
this, you will send the range and its newly made settings to the printer or to
the print file by using the Go command. Then, if you are printing a series
of ranges, you can separate the ranges by a line or page. You can even use a

command to let Masterplan know that the top of the page is aligned on your
printer.

The Procedure for Printing

There is a general procedure for printing which is described below. If you
are using more than one range, the procedure is repeated for each range.
Throughout the rest of this chapter we will discuss each group of commands
in the order that they should be issued.

(After selecting File Print Printer, or File Print File and a filename...)
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Step 1: Keeping in mind your desired print range, if you want to use
certain options, specify them first. The options are: page format (Margins
and Page Length), extra text (Headers or Footers), range borders (Borders),
printing format (Formatted and Unformatted) and worksheet documentation
(As displayed or Cell formulas). There is an additional option area called
printer control (Setup). This option allows you to use a series of invisible
characters to control such aspects of printer use as "compressed mode".

Step 2: Specify the print range.

Step . To (4 you reload or adjust paper in the printer to start a new page,
let the program know you have done so by selecting Align.

Step 4: At any point before using Go, you may select Clear to erase
settings you have made for range and options (individually or as a group).

Step 5: To send the contents of your worksheet to the printer or to the
print file (depending on which you specified), select Go.

Step 6: If you are done and have no more ranges to prepare for printing,
select Quit.

Or...

Step 7: If there are more ranges to be printed, decide if you wish to
separate them from each other. If you select Line, the ranges will be
separated by one line. If you select Page, each range will be printed on a
fresh page.

At this point you may recycle the procedure, using a new range. If you are

using the same options for the new range, skip Step 1 and move directly to
Step 2.
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Print Options

As you saw in the above section, Step 1 of the printing procedure is
selecting one or several or none of the options available. In some areas, only
one command or choice is available. In others, more than one is available.
All options are discussed in the order in which they were introduced above.

Your selections will be stored with your worksheet file if you save it.
However, they will be restored to the defaults if you clear your worksheet
with the New command. You may reset them for any new sheet that you
create.

Margins

The Options Margins command allows you to set left, right, top and bottom
margins for your printout. Masterplan has its own initial default settings for
margins. When you make changes they will be saved with your worksheet.

The Options Margins is particularly helpful in cases where you would
change fonts. For instance, if you intend to use a compressed font, the
margins would be different because there are more characters across the
paper (which are the unit of measure for margins). The default settings will
be used whenever you do not supply your own margin settings with the
Options Margins command.

The initial default margin settings for Masterplan assume a standard 8 1/2"
by 11" sheet of paper with 66 lines per page.

Left 4 spaces from left edge of paper
Right 76 spaces from left edge of paper
Top 2 lines from top of paper

Bottom 2 lines from bottom of paper

If you haven’t changed the settings, these margins will be used. You may
change one or more margin settings.

To change margins, select the Margins command from the Options menu
(OM). Now select which margin you want to set: Left (L), Right (R), Top
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(T) or Bottom (B). Specify the lines for top and bottom margins or the
spaces for left and right margins by typing the number and pressing [Return].
If you set the right margin, remember, the number of spaces are counted
from the left edge towards the right, not right to left.

Actual settings for top and bottom margins are three more lines than those
that are set if you use the optional headers and footers. The reason for this
is that Masterplan reserves three lines for each. The first line is reserved for
the header or footer itself. The additional two lines are reserved for two
blank lines which separate headers and footers from the rest of the text.
Therefore, if you are using continuous feed paper, and have set the top and
bottom margins, each page of text will actually begin three lines below one
perforation and stop three lines above the next.

Masterplan prints your ranges using the margins you select or the default
margin settings. If the worksheet you created is wider than will fit within
these margins, Masterplan prints what it can from the worksheet. If there
are labels which are too long, they will be cut off at the right margin. If
there are excess columns, they are printed last, page for page.

Page Length

The Options Page-Length command is used to set the number of lines per
page. The term "page-length" refers to the total number of lines from the
first to the last line of the sheet of paper. This command is particularly
helpful if you are using non-standard sizes of paper.

Masterplan uses an initial default value of 66 lines which is based on an 11
inch long sheet of paper using a standard type size. Using the Options Page-
Length command, you can change the page length to any number of lines
ranging from 20 to 100. If you don’t use this option, or after you end a
work session without printing or storing (using the New command),
Masterplan reverts back to its the default value.

To select the command, choose Page-Length from the Options menu (OP).

The current page length is displayed. To accept it press [Return]. To change
it, enter the number for the new page length and press [Return].
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Headers or Footers

The Options Header and Footer commands allow you to add one line each
of additional text at the top (header) or bottom (footer) of your copy directly
one line above the top margin and below the bottom margin. Masterplan
automatically adjusts the copy so that there are an additional two lines of
blank space separating the headers of footers from the body of the copy. Not
only can you add headers or footers, you can also decide whether they should
begin at the left margin, be centered or be justified to the right side of the
page.

To select the commands, select Header (OH) or Footer (OF) from the
options menu. When you are prompted to enter either a header or footer
line, you may type in any desired text up to 240 characters long and press
[Return]. We suggest that the line not exceed the margins you have set.
Masterplan automatically places you in the Edit mode while you write and
revise your entry.

Your header or footer may be divided into up to three sections, one
beginning at the left margin, one centered and one right justified. To create
separate sections, divide the sections with a vertical bar "". Each time you
use a "|", Masterplan will consider it to be a new section and position it one
section to the right of the previous one. If you begin the line with a "|", it
will center the line. If you begin the line with two [|'s, the line will be
flushed to the right. A line which doesn’t begin with a "|" will start at the
left margin.

If you reselect the Options Header or Footer commands after ycu return to
the Options or main Print menu, you can edit or erase the header or footer
when it is displayed beside the prompt.

Two items which are often included in a header or footer are the date and
page numbers. Both of these can be automatically entered by Masterplan
either singly or together. When you type a number symbol "#", Masterplan
will replace it with sequential page numbers in hard or soft copy. When you
type "@", Masterplan will replace the symbol with the current date in your
copy.
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Desk Header Footer Margins Borders Setup Page-Length Other Auto-Lf Ouit

(4 =y [0k TCancel Calc [Edit[Graph . EOIT
@:?} k
L¥.J|H| Enter Header line: ©|ESTINATED SALES FOR 198714

] .

R e e N e R R

Three Part Header with Date on Left Using @, Text Centered
and Automatic Page Numbering on Right Using #

Borders

The Options Borders command allows you to provide a border along the left
and/or top of each page of a printout. Columns or sections of columns
chosen from the worksheet are placed at the left side of the page beside the
corresponding rows to provide the left border. Rows or sections of rows are
placed above corresponding columns to provide the top border. This
command is mostly used for including columns and/or row headings on each
page of your copy.

To select the command, choose Borders from the Options menu (OB).
Select the type of border you want. Rows (R) or Columns (C). Then, select
the border range. The border range is a range which covers the rows or the
columns which you wish to use as a border. For example, if it is a series of
rows you want to use as a border, select the range with the mouse or
movement keys. If you have used this command before, your last border
range choice will be displayed. Press [Return] to enter your new range.
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When you specify the border range, be careful not to include areas from the
range that are to be printed or you will have duplicated text from the areas
they have in common.

When you print, the contents of rows which correspond with the column
addresses of the print range provide a top border. For example, if columns
A - F indicate the width of the print range and the border range is specified
as row 1, the top border will include cells Al to F1, The contents of
columns which correspond with the row addresses of the print range are
chosen to provide a left border.

If you return to the Options Borders command from the Options menu or
from the main Print menu to examine your borders, do not use [Return] to
quit the command. [Return] can break up a border if it is pressed while your
cell indicator is on the border. [Escape] will take you back to the Options
menu,.

Desk Header Footer Margins Borders Setup Page-Length Other Auto-Lf Quit

4 =1 0K [Cancel|Calc [Edit|Graph POINT
§/| AL3: (03) +R12+38

L Enter border columns: AZ2..R13

359,25 | %283, 31

Setting Borders
Formatted and Unformatted

The Options Formatted and the Options Unformatted commands are used to
format and unformat your copy by removing or adding certain format options
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and modifying the border option. The initial value is Formatted.
Unformatted is often used to prepare a file for export to another program.

To select one of the commands, select either the Formatted (OOF) or
Unformatted (OOU) from the Options Other menu. If you select
Unformatted, the copy will be printed without page-breaks, headers or
footers. Borders will be printed on the first page only. If you select
formatted, the most recently specified (or defaulted) page-breaks, headers,
footers and borders will be used as usual.

As-displayed or Cell-formulas

The As-displayed or Cell-formulas commands decide the appearance and
contents of the printout by printing the worksheet as it appears or by
printing the actual contents of each cell (cell by cell) as it was constructed.
"As-displayed" is the initial value. "Cell-formulas" is usually used to get a
printout of the formulas you’ve used in your worksheet.

To select either command, select As-displayed (OOA) or Cell-formulas
(OOC) from the Options Other menu. If you select As-displayed, the copy
will appear as it would normally in a worksheet.

If you select Cell-formulas, the copy appears one cell per line. The cells
are organized one row at a time (form top to bottom) and from left to right
of the print range. Blank cells are ignored. Each cell line contains the
information that appears in the first line of the control panel when you are in
that cell in the worksheet: cell address, format, protection status and the
actual cell contents. The actual cell contents are what was typed into the cell
such as formulas (not their values), other values the way they were entered

(that is, unformatted) and labels (including the label-prefix character).

Options Setup

The Options Setup command allows you to send preset instructions about
type style, type size, etc. to the printer when you use Go to print a range.
These instructions are a string of invisible characters entered from the
keyboard which tell the printer what special features it should use. They are
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actually printer control codes and are determined by the requirements of your
printer and by what available features you want to use. As such, they vary
in both length and content. In addition, since the printer governs the
features themselves, the characters used and even the features available will
change from printer to printer.

To select this command, choose Setup from the Options menu (OS). The
current string of printer codes will be displayed. Masterplan has
automatically changed to the Edit mode. To use this string, press [Return].
To cancel it for this work session, press [Escape], then [Return]. You may
edit it using the arrow, [Delete], and [Backspace] keys as well as inserting
other characters.

The string of printer control codes can contain up to 39 characters. Each
character is entered by typing in a backslash "\" followed by a three digit
number. This is the decimal number of the character’s ASCII code. For
example, the character, "Control O" is number 15 (in decimal ASCII). It
would be typed in like this; "\015". Do not type in the character - always
use the ASCII code. If a "\" is part of a control code, then type it twice
(once to specify that you are beginning the character and once in decimal to
include it with the code).

As we mentioned earlier, the characters you use in the string are those
which will control the features of your printer; there is no standardization of
printer control codes. To find which printer control codes work with your
printer, look in the printer manual for its control codes. Then if necessary,
translate them to the "\" plus decimal code format to enter them. Press
[Return] to enter the string of characters.

When you use Go to print or store the worksheet in a print file,
Masterplan will recall the printer control codes you have decided on for this
work session and use them.

Choosing the Print Range

The Print Range command is selected from either the File Print Printer
menu or the File Print File menu before you select Go. If you are reprinting
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the most recently specified range, there is no need to select this command.
Otherwise, the command must be used.

To use it, select Range directly from the main Print menu (R). Specify the
range with your mouse or arrow keys or by typing the cell addresses or its
range name. Press [Return] or click OK to enter it. When Go is selected, the
range is printed or sent to a print file, as you have specified.

If you want to print your entire worksheet, you can use the mouse to select
the entire worksheet. Move the mouse pointer to the box in the upper left
corner of your worksheet window above the row numbers and to the left of
the column letters. Click the mouse to select the entire worksheet. Then
click OK to accept the range.

Align

The Align command is used to let Masterplan know that you have reloaded
or realigned the paper in the printer manually and that the printer is at the
top of a new page. If you don’t use Align, Masterplan will not print any
header you may have specified.

Before you use this command, position the paper in the printer. The
printer should be at the very top of the page since the margins will be
included automatically from that point. However, you may decide to move
the paper a few lines down if the printing is unformatted (and therefore does
not include margins).

To use the command, select Align from the main Print menu (A). This will
let Masterplan know that it is at the top of the page. From this point,
margins, page-breaks, etc. will be set according to your specifications when
you select Go to print.

Clear
The Clear command can erase the print range, headers, footers and borders.

Margins, page length and printer control code setup are returned to the
default settings. The As-displayed format option is used, The Clear
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command can also be used to erase a range, borders, or formats (in which
margins, page length and printer control code setup are included)
individually.

To use this command, select Clear from the main Print menu (C). Next
choose the object of the Clear command: All (A), Range (R), Borders (B) or
Format (F).

If you select All, the print range, headers, footers and borders are erased.
Margins, page length and printer control code setup resume the defaults and
the As-displayed format option is used. No confirmation is necessary.

If you choose range, Masterplan erases the most recent print range selected.
If you choose borders, any borders set are erased. If you choose format, the
page length, margins and printer control code setup items are erased.

Go

The Go command is used after you have selected any options you wish to
use, a print range and, if you have positioned the paper manually, the Align
command. It sends your prepared copy to the printer or to a print file,
depending on whether you chose Print Printer or Print File to begin with.

When you are ready to send your copy to a printer or to a file, select Go
from the main Print menu. Your prepared copy is sent to the printer or
placed in a print file. You can stop printing before the printing is completed
by issuing a break [Control][Undo]. The printing may not be interrupted
immediately because there still may be characters in the printer’s own
"buffer". These excess characters will be printed before printing comes to a
halt.

After you have issued Go and printed your worksheet, Masterplan returns
to the main Print menu so you can go through the printing cycle again.
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Quit

The Quit commands (Q) back you up one menu each time you use them.
For instance, if you are in the Options menu and you use Quit you are
moved back to the main Print menu. From the main Print menu, Quit moves
you back to the Ready mode.

Advance a Line

The Line command advances the paper in your printer, one line at a time
so that you can create some space between different print ranges. To use the
command, select Line from the main Print menu (L). An extra blank line is
added between the last print range and the one coming up. Each time you
select Line, an additional blank line is added.

If you reach the bottom of the page, as specified by the margin and page
length settings, Masterplan advances the paper to the next page. If you used
the Footer option, the footer will be printed in the correct position before the
page is advanced.

Advance a Page

The Page command advances the printer to the top of the next page after
one print range, to begin the next print range. It is also a good idea to use
this command after the last print range ended. Unless you use the Align
command, the program thinks the next print range will begin right below the
ending line of the last print range. For instance, if you ended your last
printing in the middle of the page, Masterplan thinks the next printout begins
from the middle of the page. Therefore, for the first page of the printing it
will only print on what it thinks is the last half of the page left over from
the last printing.

To use the command, select Page from the main Print menu (P). After
ending with a print range, Masterplan advances to the top of the next page.
If a footer is to be printed at the bottom of the page, the footer will be
printed before advancing to the next page.
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EDIT COMMANDS

Introduction
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The Edit Menu

Edit commands are used to perform such operations as undoing the previous
cell entry even after [Return] is pressed and turning and off the grid lines on
your worksheet. You can insert and delete rows and columns in your
worksheet. You can also copy, move and erase ranges in your worksheet.

Undo

The Undo command is used to undo the previous cell entry after [Return]
has been pressed (the entry has been set). The Undo command cannot be
used to undo an entry once you have entered data into a new cell.

This command can also be used to undo what you just undid. For instance,
if you enter data into a cell which previously had data in it, undo will undo
your most recent entry and display your previous entry. If you use undo
again, it will redisplay your most recent entry, and so on. This command is
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very useful for things like a temporary change in data for your graph to
check a different value. You can toggle between two different values in a
cell. Remember though, that once you have entered data into a different
cell, this new cell becomes the object of the undo command.

To use the Undo command, select Undo from the Edit menu (/EU). Your
previous entry will be displayed in the last cell that data was entered. Select
undo again to restore the most recently entered data.

Copy

The Copy command is used to create new cell entries by copying, or
duplicating existing cell entries. The Copy command can be used to copy
both values and labels. In its most sophisticated use, the Copy command can
be used to copy formulas and produce projections and extrapolations
throughout entire ranges of your worksheet.

Copying Labels and Values

One of the simplest uses of the Copy command is to copy a label or a plain
value (not a formula) from one cell to another or from one range to another.
It is important to note that the Copy command erases the previous contents of
the cell you are copying into and there is no way to recover this information.
Any formulas which refer to the copy cells by cell address will remain valid
and use the new contents.

"To" (target) and "From" (source) copying ranges should not overlap one
another. Overlapping leads to inaccurate copying, except for those rare cases
where the two areas share the same upper left hand corner.

You can use a single cell or a range to copy. Ranges must always be
rectangular in shape. Cells which are separated from each other must be
copied one at a time.
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Copying Formulas

To copy formula(s) of one or more cells to another area, use the same
procedure described for copying values and other characters. The difference
concerns only those formulas which reference cell addresses. The exact
match of the copied cell formula to the new cell formula depends on whether
you use absolute cell addresses, relative cell addresses, or mixed cell addresses
in the formula. The concepts of absolute, relative and mixed cell addresses
are discussed in the "Building Formulas Using Operators and Functions"
chapter of the Handbook.

If you use an absolute cell address in a formula, the formula is transferred
to the new cell using identical operations and identical cell addresses without
regard to its new location.

If you use relative cell addresses in a formula, the formula transfers
identical operations. However, because the cell addresses are relative, the cell
addresses change in accordance with their new location. If you use a cell
address in a formula which is two spaces up and one to the right of the
original cell, it will be two spaces up and one to the right in the copied cell.
In copying a range, Masterplan adjusts each of the cell addresses
independently.

When a formula using a range name in place of cell address is copied,
Masterplan assumes that the range is relative. To make the range absolute,
precede the range with the absolute symbol "$". This will make the range
absolute as a group (that is, each cell of the range is considered to be
absolute).

Mixed cell addresses in a formula act as a combination of absolute and
relative references. The absolute part of a mixed cell address, whether it is
the column or the row, will remain the same. The relative part of a mixed
cell address is different in the copied cell formula than it is in the original.
The relative part of the address depends on the distance relationship between
the original formula cell and the referenced cell for its location. Basically,
this means that the cell address of the formula changes when it is copied,
although the change is only in one direction.
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Using Copy

First, select the Copy command from the Edit menu (/EC). In response to
the prompt for a range, use your arrow keys, your mouse or type the anchor
and end cell coordinates, separated by a period, to specify the range or the
cell to be copied from (source range) and press [Return] or click OK to
accept it. As an alternative, you can select the range to be copied from with
the mouse before issuing the Copy command.

Once you have selected a source range or cell, Masterplan asks for a range
to be copied to (target range). In response to this prompt, specify a range or
cell in the same way as before and press [Return] or click OK. Masterplan
will do the rest of the work.

Move

The Move command is another powerful command available with
Masterplan. It transfers a cell or range of cells from one location in your
worksheet to another. The relationships between the moved cells are not
disturbed. This command is particularly suitable for redesigning areas of
your worksheet.

Moving cell entries is just like picking them up from one location and
placing them in another. Not only are the formulas and other relationships
between them unchanged, but all formulas which refer to the moved cells are
kept the same as before.

When you move a cell which is located at the top left or bottom right
corner of a specified range, you will alter the structure of the range (its
range definition). Any formulas which refer to that range will be altered to
take into account its new definition. If you move any other cell of a range,
it will remove the cell from that range without affecting the range definition.
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Changing a Range’s Definition

If you move the contents of a range to another location, it is important to
note that any previous entries in that location will be erased. Any cells
which used those cell references now display the value "ERR" instead of their
former values.

Using Move

To issue the Move command, select Move from the Edit menu (/EM). In
response to the prompt for the range to be moved, specify either a range or a
single cell. You may use your arrow keys, mouse or type the anchor and end
cell coordinates (separated by a period). As with the Copy command, you
can select the range to be moved with the mouse before you issue the move
command. Now press [Return] or click OK to accept the range.

After selecting a source range and in response to the second prompt,
indicate the area where you want the cell(s) moved to, using the same method
as before. This will be the target range. Press [Return] or click OK to
accept the range. Masterplan will now move your cell or range to its new
location.
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Erase

The Erase command is used to erase the contents of a cell or a range of
cells. As with the Copy and Move commands, you can select the range with
the mouse before you issue the Erase command. The Erase command does
not require confirmation so it should be used with care.

To use the Erase command, select Erase from the Edit menu (/EE). In
response to the prompt for a range, use the mouse or arrow keys to specify
the range you want erased. Press [Return] or click OK to confirm the range
and the contents of the range will be erased.

Insert Rows and Columns

There are two commands which are used to insert space in a worksheet.
The Insert Rows command is used to insert one or more rows and the Insert
Columns command is used to insert one or more columns in your worksheet.
These commands are for adding space for additional data, or for making your
worksheets more attractive.

When a row or column is added, the other rows or columns move downward
or to the right to accommodate the inserted areas. Usually, no rows or
columns are lost at the ends of your worksheet since the borders of the
worksheet expand to allow for inserted areas. Masterplan automatically
adjusts cell references in moved rows or columns to correspond with their
new locations. Initially, the inserted areas use the default formats (for value
and label displays, and for column width of rows).

To insert rows, first place the cell indicator on the row below which you
want the space inserted. Select the Row command from the Edit Insert menu
(/EIR). A prompt will appear asking for a range. Use your arrow keys or
the mouse to indicate the number of times you want a row inserted and press
[Return] or click OK.
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To insert columns, first place the cell indicator on the column before which
you want the space inserted. Select the Column command from the Edit
Insert menu (/EIC). A prompt will appear asking for a range. Use your
arrow keys or the mouse to indicate the number of times you want a column
inserted and press [Return] or click OK.

Delete Rows and Columns

The two commands Delete Rows and Delete Columns, are used to delete
one or more complete rows or columns in your worksheet.

After deleting a row or a column, the remaining rows and columns are
moved up or left to fill the gap made by the deleted space. If there are any
cell references in your worksheet which refer to one of the deleted cells, the
formulas depending on them display the "ERR" value.

To delete rows, first place your cell indicator over the first row you wish to
delete. Select Row from the Edit Delete menu (/EDR). In response to the
prompt, use your arrow keys or mouse to specify the number, or range of
rows you want deleted and press [Return] or click OK.

To delete columns, first place your cell indicator over the first column you
wish to delete. Select Column from the Edit Delete menu (/EDC). In
response to the prompt, use your arrow keys or mouse to specify the number,
or range of columns you want deleted and press [Return] or click OK.

Grid

The Grid command is used to turn on and off the gridlike pattern on the
worksheet display. If you want to turn the grid off, select Grid from the
Edit menu (/EG). To turn the grid on select it again. The grid status is not
saved with your worksheet.
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WORKSHEET COMMANDS
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The Worksheet Menu

The Worksheet menu is used to design a worksheet which suits your needs.
The commands affect your worksheet as a whole or are used to make large
scale changes in it. Worksheet commands are also used to manage your
worksheet display.

Some of the commands are global in nature which means they are
responsible for changes that take place throughout the worksheet, such as
Format, Protect and Recalc commands. Other commands include splitting the
worksheet window and freezing titles on the screen.
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Format

Masterplan considers values separately from labels when formats are set.
Worksheet Format commands are used to change the format of number cells
(i.e. cells which display values). However, these commands have no bearing
on the display of labels.

The Format commands only determine how Masterplan stores values for
display, they do not change the values themselves. This is important to
remember because, at one point, you may round your worksheet values off to
two decimal places. For example, a number such as 314.323 will then be
displayed as 314.32. 1If, at a later point, you decide to change the display
setting to four decimal places, Masterplan remembers the original value and
now displays the number as 314.3230. Masterplan can effectively remember
values to 15 decimal places. In addition, if a format makes a value too long
to be displayed within a cell, asterisks are displayed across the cell. For the
value to be displayed, the format must be changed so the display is shortened
or the column width must be widened to accommodate the value in the cell.

The Worksheet Format command can be used in conjunction with the
Range Format command. Where it is used, the Range Format command
overrides the Worksheet Format command. If, for example, you numbered a
series of rows in a worksheet, you might want to have the numbers displayed
as positive integers. What if all the other values needed to be displayed as
dollars and cents? The first thing you would do is select the Currency option
of the Worksheet Format command. Notice that all your values are now
displayed as dollars and cents. Now select the Range Format command and
specify the column of values numbering the rows as the range. Select the
General Format option. The column of numbers is displayed as positive
integers while the other values of the worksheet continue to be displayed as
dollars and cents.

Select the Format command from the Worksheet menu (/WF). Then, select
the display format you want and enter it. There are nine available options.
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Currency:

Select Currency (C) from the Format menu. U.S. dollar symbols are used.
Negative values are displayed in parentheses. Commas are used after every
third digit to the left of the decimal point. Enter the number of decimal
places you want the values rounded off to. Your choices are 0 to 15. Press
[Return].

Date:

Select Date (D) from the Format menu. Date causes the values of your
worksheet to be considered "serial dates" and to be translated and displayed as
dates. This format is most often used with date arithmetic (see Date
Arithmetic in the chapter, Building formulas using Operators and Functions).
With the Date format, you have three choices: 1) Day-Month-Year. 2) Day-
Month and 3) Month-Year. Day and year are displayed numerically (with
two digits each) and month is displayed as abbreviated text (with three
letters). For example, a date would be displayed as "09-MAR-85".

Fixed:

Select Fixed (F) from the Format menu. The Fixed format allows you to set
the number of digits you want displayed after the decimal point. Enter the
number of decimal places, from 0 to 15, to which all values are to be fixed
and press [Return].

General:

Select General (G) from the Format menu. The General format is the
standard format. Trailing zeros after the decimal point are not displayed.
Large numbers are displayed in scientific notation. This is the initial default
format for Masterplan.

Percent:

Select Percent (P) from the Format menu. The Percent format displays values
as percentages. It displays a percent sign after the number. Enter the
number of decimal places you want percentages rounded off to, from 0 to 15,
and press [Return].

Scientific:

Select Scientific (S) from the Format menu. This format displays your values
in scientific notation, rounded to the number of decimal places specified.
Enter the number of decimal places, from 0 to 15, and press [Return].
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Text:

Select Text (T) from the Format menu. This displays the formulas instead of
their current values.

The Text format is often used to compare values displayed with the
underlying formulas. This is done by using the Worksheet Window command.
One window is used to view the values while the other window is used to
view the underlying formulas.

Comma:

Select Comma (,) from the Format menu. Your values will be displayed with
commas after every third digit to the left of the decimal place with the
number of decimal places specified. Negative numbers are displayed in
parentheses. Enter the number of decimal places, from 0 to 15, that the
number is to be rounded to and press [Return].

Plus or Minus:

Select Plus or Minus (+) from the Format menu. This format is used to
create horizontal bar graphs. The number of symbols represents the integer.
",.n

+' is used for positive integers, "-" is used for negative integers and "." is
used for zero.
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Label-Prefix

To change defaulted settings for label formats, use the Worksheet Label-
prefix command. Label formatting information is stored differently than
numerical formatting is. Labels do not change their appearance like values
do. Instead, changes in label formatting come about from the way labels are
placed in their cells: either flushed left, flushed right or centered. Another
prefix the "\" character can be used individually to repeat the cell contents
across the cell. There is no Worksheet command option available for the
repeating label format.

A prefix character (or label prefix) is one of four characters which
determine a label’s appearance in a cell. When you are in the Label or Edit
mode, it will appear in the control panel as you type in the label. The prefix
character is not displayed in the worksheet, however.

Prefix Effect

2 Align to Left
5 Align to Right
2 Center

The label formatting information is stored with the labels individually.
However, with the Worksheet Label-Prefix and the Range Label-Prefix
commands, Masterplan can default an area to use one of three label prefixes
(left, right or center) when a label is entered.

Since label alignment is initially defaulted to the left, you will notice that if
you type in labels without changing the label format in some way, all your
labels will be preceded by an apostrophe (*) which aligns them to the left of
the cell.

By selecting the Label-prefix command from the Worksheet menu (/WL),

_you can change the original left alignment to the right, or center it. The

Worksheet Format command affects only those labels you create after issuing
a change. When you specifically enter a label prefix, or if you use the Range
Label-Prefix command, you will override the Worksheet Label Prefix.
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Although the fourth label prefix (\) is not available with the Worksheet
Format command, it can be used individually to make a label repeat itself
throughout the cell. When used with the Copy command, this feature is
especially handy for typing lines and dashed lines across your worksheet.

If the label is as long, or longer than its cell, alignment doesn’t matter
because Masterplan will fill the cell and so on until the entire label has been
accommodated. - Although a cell can contain as many as 240 characters, the
display will show only as many as will fit across the screen at one time.

Any time you begin a label with a number or any other character which
might cause Masterplan to think that you are entering a value instead of a
label, you must precede it with a prefix character to indicate that it is a
label.

There will be times when you wish to change alignment of already existing
smaller groups or of single-cell labels. In such cases, use the Range Label-
Prefix command for groups of labels or the Edit mode for single-cell
changes.

Column-Width

When we speak of column width in your worksheet, we are referring to the
number of character spaces it takes to fill a cell in that column. Your
worksheet is structured as a gridlike pattern of cells which is organized into
columns and rows. Any changes you make in the width of one cell will be
reflected in all other rows of the column.

Although the column width is initially set to 9 spaces, by selecting the
Worksheet Column-width command, you may change the width of all
columns of your worksheet. To do so, select Column-width from the
Worksheet menu (/WC). Masterplan will display the current width setting.
To set a different column-width, you can use your Left and Right arrow
keys or type in the number of characters you want for the width and press
[Return].

The Right and Left arrow keys adjust the current cell width. Each time
you press [Right], one space is added to the width. Each time you press
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[Left], one space is subtracted. When you reach the desired width, press
[Return].

The Worksheet Column-width command only affects the window in which
the cell indicator is located. For example, if you have split windows and the
cell indicator is in the first window when you issue the command, then only
the first window will be affected.

Titles

The Worksheet Titles command is used to lock rows, columns or both in
place on your screen so that when you scroll through your worksheet, the row
and/or column headings will remain visible.

On your screen, column letters and row numbers form a border near the top
and at the left edge of the screen. When you move the cell indicator down or
to the right, notice that these borders will remain in place to indicate your
position on the worksheet. The borders are said to be "frozen".

Sometimes, you will find that it is convenient to maintain a vertical or
horizontal section of your worksheet in one place while you scroll through
and make changes in other sections. Just as the borders at the left and top of
the worksheet display are "frozen" you can freeze the worksheet sections
horizontally, vertically or both. This is known as "title locking" or "freezing
titles".

To freeze your titles, first select the cell to the right of or beneath the
columns or rows you wish to freeze. Next, select the Titles command from
the Worksheet menu (/WT). Then select Rows (R), Columns (C) or Both (B).
The titles are now frozen on the screen from the position of the cell indicator
to the left edge of the worksheet (for columns), top edge of the worksheet
(for rows) or both (for both). The frozen area will remain in place as you
scroll through your worksheet in any direction.

An additional difference between this and other areas of your worksheet is
that you will not be able to enter the frozen area using the arrow keys in the
Ready mode. This is a protection feature which protects the titles area from
accidental alteration. Still, there will be times when you need to enter the
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titles area. You may do so by using your mouse or the GoTo function,
[Function 5]. If you use the mouse, you can make changes to any cell in the
frozen area. When you use the GoTo function, the titles area will be
duplicated below and/or to the right of the original titles area. Any changes
you make to the duplicate titles area will be reflected in the original titles
area. Once you scroll the duplicate area off the screen, it will no longer be
displayed.

To unfreeze titles, select the Clear command from the Worksheet Titles
menu (/WTC). The worksheet display returns to normal.

Windows

The Worksheet Window command allows you to split the screen into two
segments or windows, so that you can simultaneously view different,
unconnected areas of your worksheet.

There are times when you want to compare different sections of your
worksheet. You can even view the same section of the worksheet in different
windows and in different ways. The easiest way to do this without printing
is to use the window feature of Masterplan. Windows may be created
horizontally or vertically.

To create a horizontal window, place the cell indicator in the row below
where you want the division to be. Select the Window command from the
Worksheet menu (/WW). Next select Horizontal (H). The display will be
divided into two horizontal windows. The cell indicator will appear in the
last row of the first window.

To create a vertical window, follow the same procedure used to create a
horizontal window. The only difference will consist of selecting Vertical (V)
rather than Horizontal as the third step in the procedure.

When you are ready to close the second window, use the Worksheet Window

Clear command (/WWC) or the Close Box in the upper left corner of the
second window.
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Just like the first window, the split windows use the grid pattern of the
worksheet as a basis for operation. The actual position of the cells on the
worksheet are remembered and displayed on the borders. All commands
which work on the grid as a whole, except for printing and saving, will work
separately on each of the windows. It’s important to remember that although
you are now viewing two sections of your worksheet rather than one, it is
still the same worksheet.

In most ways, the windows are independent from one another. The cell
indicator can be used to move around each window. Each can have its own
display formats and separate column widths and you can even use the split
window feature to view the same area differently in both windows. For
example, in one you could see the underlying formulas displayed in their
cells, while in the other, you could vievc( their current values.

The window in which the cell indicator is located, is the one which is
active. The cell indicator can be moved from one window to the other in
two ways. The first is by using the Window function, [Function 6]. By using
[Function 6] from the keyboard, the cell indicator will be moved from
window to window. The other way to move from one window to another is
by using the mouse. Move the pointer to the other window, then click the
mouse button.

Synchronized Scrolling

When you first use the Windows command, the windows are synchronized
horizontally or vertically, depending on which way you split the window.
This means that horizontal windows scroll to the left or right together, but
aren’t linked when you move up or down. The same holds true for vertical
windows. Scrolling up or down in one window is synchronized with the
other, while horizontal scrolling remains independent.

This synchronized scrolling can be unlinked. To do so, select the Unsync

command from the Worksheet Window menu (/WWU). The scrolling is no
longer synchronized.
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To reactivate synchronized scrolling, select the Sync command from the
Worksheet Window menu (/WWS). The scrolling is now relinked from left to
right for horizontal and up and down for vertical.

Recalc

The Recalc command allows you to turn the automatic calculation feature
of Masterplan on and off. Calculation affects only the formulas and values
which are related to the formulas. Calculation and recalculation of
worksheets is also discussed in the chapter, Building Formulas Using
Operators and Functions.

Automatic is the default setting. Every time you add or change an entry,
Masterplan will automatically calculate your worksheet for you. Automatic
recalculation can be time consuming, particularly when your worksheet is
fairly large. You may switch to Manual Recalculation to save time between
entries. Select Manual from the Worksheet Recalc menu (/WRM). Now the
worksheet will only be recalculated when you want it to be. To switch back
again, select Automatic from the Worksheet Recalc menu (/WRA).

While the worksheet is in manual recalc, the Calc icon will become
highlighted after any data entry to remind you that the worksheet needs to be
recalculated. You can force recalculation at any time by pressing [Function
9] or clicking on the Calc icon.

Protect

Often, worksheets are created to be used by untrained personnel. Because
of this, it may be desirable to protect areas of your worksheet from
accidental changes, leaving only the areas which require entry accessible.
This is done by using the Worksheet Protect command (/WP) in conjunction
with the Range Unprotect command (/RU). The Worksheet Protect command
is the only command which can activate worksheet protection. If it is not
enabled, the Range Protect command will be ineffective.

Once you have protected the worksheet by enabling Worksheet Protect, you
may then use the Range Unprotect command to unprotect areas of the
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worksheet for data entry. Should you later decide to protect areas
unprotected with the Range Unprotect command, you may then use the
Range Protect command to protect those areas. If you decide to turn off
protection altogether, simply disable protection.

As an example, you might wish to create a monthly balance sheet to be
used by your bookkeeper. Worksheet Protect is enabled to protect your
formulas, labels and instructions. Since the monthly values will have to be
entered each month, use the Range Unprotect command in those cells to
override the Protect command. In the ranges you have specified with Range
Unprotect, protection will be lifted from the cells.

Once you select the Worksheet protect command, you will be offered two
choices: Enable (on) and Disable (off). When Worksheet Protect is enabled,
the Protect icon appears in the control panel.

Status
Select Status from the Worksheet menu (/WS). Information will be
displayed about settings and selections that are currently in effect. The

percentage of memory still available for your use is also displayed. Click the
mouse button to return to your worksheet in the Ready mode.

115




Ditek International

Masterplan

116




Masterplan Range Commands

RANGE COMMANDS
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The Range Menu

Range commands are used to process groups of cells in a worksheet. Many
of the commands are similar to those found in the Worksheet menu and in
other menus. The most significant difference is that instead of being carried
out through the entire worksheet, Range commands only affect a specified
range. A range is a single rectangular area consisting of one or more
contiguous cells.

Range parameters are set through the use of two cells, the "start" (or
anchor) and the "end (or free) cells. The upper left cell of a range is initially
the start cell and is considered the first cell of the range. The lower right
cell, which is usually the free cell, is used to expand or shrink the borders of
the range. When ranges consist of only one cell, the start and end cells are
the same. Range borders are always exactly horizontal and vertical, the
corners forming 90 degree angles. Frequently, ranges consist of rows,
columns or some other type of rectangular area.
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When to Specify a Range

Many Masterplan commands require that one or more ranges be specified.
Masterplan will prompt you when it requires a range as part of a command.

If you are using a mouse, there are times when you may specify a range
before selecting a command. Then, when you invoke the command, you may
accept the range or you may define a new one. For example, if you select
the Copy command after you specified a range with your mouse, you may
use the range by pressing [Return], clicking the right mouse button or
clicking OK in the control panel when you are prompted for the source
range. If you do not wish to accept it, you may select another range.
Masterplan will use the most recently specified range.

With some commands such as Range Sort, ranges are remembered from the
first time and displayed if you use the command again. To accept these
ranges press [Return] or click OK. To change the range, specify a new range
with the keys or the mouse. For more information on specifying ranges see
the "Selecting a Range" section in this Handbook.

Range Format

Just as the Worksheet Format command is used to set the entire worksheet
display of numerical values, the Range Format command is used to set the
display of numerical values in a specified range. The Range Format
command overrides the Worksheet Format command in those areas where it is
used.

As with the Worksheet Format, the values themselves aren’t changed, only
the way they are displayed is. If a selected display format makes a value too
long to fit in a cell, asterisks are placed across that cell. The original values
are remembered. To display the value again, you must alter the column
width or change the format.

118




Masterplan Range Commands

To set a format, select Format from the Range menu (/RF). Next, select
the format and any necessary information. Then specify the range to be
formatted using the mouse or arrow keys. The format options are described
below.

Currency:

Select Currency (C) from the Format menu. U.S. dollar symbols are used.
Negative values are displayed in parentheses. Commas are used after every
third digit to the left of the decimal point. Enter the number of decimal
places you want the values rounded off to. Your choices are 0 to 15. Press
[Return].

Date:

Select Date (D) from the Format menu. Date causes the values of your
worksheet to be considered "serial dates" and to be translated and displayed as
dates. This format is most often used with date arithmetic (see Date
Arithmetic in the chapter, Building formulas using Operators and Functions).
With the Date format, you have three choices: 1) Day-Month-Year. 2) Day-
Month and 3) Month-Year. Day and year are displayed numerically (with
two digits each) and month is displayed as abbreviated text (with three
letters). For example, a date would be displayed as "09-MAR-85".

Fixed:

Select Fixed (F) from the Format menu. The Fixed format allows you to set
the number of digits you want displayed after the decimal point. Enter the
number of decimal places, from 0 to 15, to which all values are to be fixed
and press [Return].

General:

Select General (G) from the Format menu. The General format is the
standard format. Trailing zeros after the decimal point are not displayed.
Large numbers are displayed in scientific notation. This is the initial default
format for Masterplan.

Percent:

Select Percent (P) from the Format menu. The Percent format displays values
as percentages. It displays a percent sign after the number. Enter the
number of decimal places you want percentages rounded off to, from 0 to 15,
and press [Return].
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Scientific:

Select Scientific (S) from the Format menu. This format displays your values
in scientific notation, rounded to the number of decimal places specified.
Enter the number of decimal places, from 0 to 15, and press [Return].

Text:

Select Text (T) from the Format menu. This displays the formulas instead of
their current values.

The Text format is often used to compare values displayed with the
underlying formulas. This is done by using the Worksheet Window command.
One window is used to view the values, while the other window is used to
view the underlying formulas.

Comma:

Select Comma (,) from the Format menu. Your values will be displayed with
commas after every third digit to the left of the decimal place with the
number of decimal places specified. Negative numbers are displayed in
parentheses. Enter the number of decimal places, from 0 to 15, that the
number is to be rounded to and press [Return].

Plus or Minus:

Select Plus or Minus (+) from the Format menu. This format is used to
create horizontal bar graphs. The number of symbols represents the integer.
"+" is used for positive integers, "-" is used for negative integers and "." is
used for zero.

Reset:

Select Reset (R) from the Format menu. The Reset command is used to
counter the effect of the Range Format command. Range Format Reset
returns a range to the default format.
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Range Label-Prefix

The Range Label-prefix command is used to change the display of labels in
a range so that they are aligned to the right or left of the cell or centered.
Any labels you wish to add to the range at a later time will conform to the
Worksheet standards rather than to the range’s standards. If you wish to
change the position of the added labels in their cells, you must do so
individually while you are in the Edit mode.

The Range Label-prefix command is similar to the Worksheet Label-prefix
command. The major difference between the two is that the effect of the
Worksheet command applies to the entire worksheet while the Range
command is only effective in the range specified. Where both are used, the
Range Format command overrides the Worksheet Format command.

To use this command, select Label-Prefix from the Range menu (/RL).
Select Right (R), Left (L) or Centered (C). Now specify the range and press
[Return] or click OK.

Range Name

Masterplan allows you to give a specific name to each range that you create.
This can be particularly useful if you have certain frequently used ranges.
Naming a range makes it more personal and, therefore, easier to remember.
For each worksheet you have created, Masterplan allows you to keep a list of
range names to designate ranges in it. These range names can be saved and
retrieved with most file commands. However, the File Combine command
does not allow you to keep range names when you combine different
worksheets. This prevents conflicts in named ranges.

When Masterplan prompts you for a range to be processed, you can use a
range name. To have a list of current range names displayed, use the Name
function [Function 3]. To select a range name in response to a prompt, either
point to it with your mouse ar arrow keys or type in the range name and
press [Return] or click OK.

There are three commands which relate specifically to range names: the
Range Name Create command, the Range Name Delete command and the
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Range Name Reset command. In addition, the Range Name Label command
is a special command which is used to name single celled ranges.

Range Name Create

The Range Name Create command is used to give a name to a specific
range. Range Names make it easier to view or use specific ranges in
command procedures. Once a range has been named, its definition can be
revised at a later date without changing its name by changing the position of
its start and end cells.

To name a range, select Create from the Range Name menu (/RNC). In

response to the prompt for a range name, type a name of your choice and
press [Return].

Like file names, range names can be typed in upper or lowercase.
Masterplan displays all letters in uppercase. Range names can be up to 15
characters long. We suggest that you do not use space characters or the +, -,
*, / and * characters. This is to avoid similarities with formulas, commands
and labels since that may cause confusion for Masterplan. For the same
reason, we advise you not to use range names that look like cell addresses.

The last step to creating a range name is specifying the range. In response
to the prompt, specify a range using the mouse, arrow keys or typing the
addresses and press [Return] or click OK.

To use a range name, type the range name or choose it from the range
name list (which can be called up with the Name function, [Function 3]) and
press [Return] or click OK. To return to the Ready mode, issue a Break by
pressing [Control][Undo] or clicking on the Mode indicator in the control
panel. The list of range names can only displayed in modes where it is
appropriate such as the Point mode and commands that ask for a range such
as Copy, Move, etc.

To redefine the borders of a named range, select the Range Name Create
command. The list of current named ranges will be displayed. Point to the
range you want with the mouse or arrow keys, or by typing the name. Press
[Return]. Now specify the new range with your mouse, arrow keys or by
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entering the cell addresses and press [Return] or click OK to accept the new
range. All formulas with cell references which referred to a range by that
name will be updated to reflect the new range.

Range Name Delete

The Range Name Delete command is used to delete range names that are no
longer needed. This means that the deleted range name will not appear in
the range name list, nor will it be used to refer to a range anymore,
However, the cell contents of the range are unaffected. Formulas with cell
references which previously referred to the range by name now refer to the
range by using the cell addresses.

To use the Range Name Delete command, select Delete from the Range
Name menu (/RND). Select the name you want deleted, either by typing it
or pointing to it from the list and press [Return] or click OK.

Range Name Reset

The Range Name Reset command is used only when you wish to delete all
range names from your worksheet.

Select Reset from the Range Name menu (/RNR). All range names are
deleted from the Range Name list. Ranges can no longer be referred to by
name. All formulas which previously referenced cells by range name now
use cell addresses.

Range Name Label

The Range Name Label command is used to create a string of one celled,
named ranges of key values rather than their cell coordinates or the values

themselves.
Certain key formulas can also be single celled, named ranges, This can be

done with the Range Name Create command. However, when there are
several cells in a row that contain key formulas and each has an identifying
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label located directly above, below, to the left or to the right, it may be
easier to use the Range Name Label command to name all the ranges at once.

The names of these ranges are derived from the string of labels. The labels
must either be all to the left, all to the right, all below or all above the value
cells.

To use the Range Name Label command, first position the cell indicator on
one end of the string of label cells you want to use. Select Label from the
Range Name menu (/RNL). Specify whether you want to name the value
cells to the Right (R), Left (L), Up (U) or Down (D). Specify the range of
labels you want used and press [Return] or click OK. Remember, as with all

range names, Masterplan can only use the first 15 characters of the label to
give the range its name.

Range Protect and Unprotect

The Range Protect and Range Unprotect commands are used only in
conjunction with the Worksheet Protect commands. In the ranges where they
are used, the Range commands override the Worksheet commands. This is
particularly effective since it allows you to have both protected and
unprotected cells in your worksheet. Range Protection of cells is used when
you wish to keep certain areas (cell ranges) free from editing changes or
other accidental changes. Protected cells cannot be edited and will not accept
data. If you attempt to enter data into a protected cell, Masterplan will tell
you that the cell is protected. The Range Protect and Unprotect commands
have no effect unless Worksheet Protect has been enabled.

Range Protect:

The Range Protect command may only be used when Worksheet Protect has
been enabled (/WPE). It is usually used within a larger range which has been
unprotected. To use Range Protect, select Protect from the Range menu
(/RP). Specify the range to be protected and enter it. Masterplan will set up
protection for that range.
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Range Unprotect:

To use the Range Unprotect command, select Unprotect from the Range
menu (/RU). Specify the range to be unprotected and enter it. Masterplan
will unprotect that range.

The Range Protect and Unprotect commands can be used to counteract one
another. If you have a range which you previously protected, you can
unprotect it by using the opposite command.

Range Sort

The Range Sort command allows you to change the order of rows (records)
or any other series of data in your worksheet. For example, you can use it to
alphabetize a set of records by last name. This command only changes the
order of rows (records); the order of columns in your worksheet is not
affected by the Sort command.

When you select the Sort command from the Range menu (/RS), you call up
a menu of Sort commands. These commands are: Data-Range, Primary-key,
Secondary-key, Reset, Go and Quit. Sorting data requires the following
steps. First you must specify the range to be sorted with the Data-Range
command. Next you must specify the field (column) which is to be sorted
using the Primary-key command. The third step, which is optional, is to
specify the second field which serves to further sort any duplicates in the
primary field. Finally select Go to sort your data.

Before going on to discuss each of these steps, it is necessary to explain two
aspects of the sort command which you should be aware of. The first aspect
has to do with the effect of sorting data. Once you have used the Sort
command, there is usually no way to restore the order of the records as
Masterplan does not recall the original order. To avoid such a problem, you
may create an extra column for numbering the rows in sequence before you
issue the command. That way, you can always resort your data using this
column as the primary key to restore the original order of your data.

The other aspect has to do with the relation of formulas with cell references
to rows. The Range Sort command changes the position of rows and this can
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affect entries which contain formulas with cell references. However, there
are some general rules pertaining to the use of formula references where the
Sort command is used: all references to cells outside the range to be sorted
should be absolute. Within the range, references to cells in the same rows
can be left relative, especially with regard to columns. References to cells in
different rows of a range should not be used.

Data-Range

The range, or portion of the rows, which you want to sort must be
specified first. You may choose to sort the entire worksheet or just one
section of it.

First, select the Data-Range command from the Range Sort menu (D).
Specify and enter the range. Once you have entered a range for the Sort
command, Masterplan remembers it. The next time you use the Data-Range
command, this range will be displayed. If you use the Sort command several
times, the most recent range will be displayed. Press [Return] or click OK to
accept this range or specify a new one.

Primary-key

This is the second mandatory command. It chooses the primary key column
and the order (highest to lowest or lowest to highest) in which the primary
key column will be sorted. The primary key column and the way it is sorted
determines the order of the rows.

Select Primary-key from the Range Sort menu (P). Use your mouse or

arrow keys to move the cell indicator to the column that you want to use for
the primary key and press [Return] or click OK.
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Now decide on the order of the primary key column. You can select
Ascending (A) or Descending (D) order. The order is decided according to
the following rules of precedence:

1. Blank cells.

2. Label cells. The alignment prefix characters are ignored but the rest of
the label’s characters are used to put the labels into ASCII order. ASCII is a
standard computer code which assigns a number to each character available
on the keyboard.

3. All other cells in the order of the number or formula value.

If you have used the Primary-key command before, Masterplan remembers
your most recent choices and you will not have to respecify the primary-key
field again unless you want to change your choices. Press [Return] to accept
the choices displayed in response to the Primary-key command selection. To
change them, specify the primary key field and sorting order of your choice.
Do not use [Escape]. Masterplan will display and use your most recent
selections.

Secondary-key

If there is more than one row in the primary column with the same entry,
the order of those rows after the sort will be unpredictable since rows with
identical information are considered equal. To help with this problem, the
Secondary-key command is provided. It is used to sort the order of rows
with identical primary-key information. For instance, if you want to sort a
list of names and addresses by last name, you may decide to sort the list
further by sorting the list of rows by first name. To do this, select the last
name column as primary key and the first name column as secondary key.

After selecting the Secondary-key from the Range Sort menu (S), use this

command as you did the Primary-key command. The sorting order is
decided the same as it is for the Primary-key.

127




Ditek International Masterplan

The next time you use Range Sort, the secondary-key selections you made
will be displayed if you use the Secondary-key command. Accept it or revise
it as you would the Primary-key command.
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Reset

The Reset command is used when you wish to erase all the selections you
have made concerning the Data-Range, Primary-key and Secondary-key
commands. You can use this command to erase choices made just before or
to erase choices made during a previous sort operation.

Select the Reset command from the Range Sort menu (R). Your selections

for Data-Range, Primary-key and Secondary-key are erased. If you use the
Sort command again, you will have to make new selections.
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Go

The Go command is used when you have made all necessary selections for
the Data-Range, Primary-key and Secondary-key (optional) commands and
feel that you are ready to sort your data.

Select the Go command from the Range Sort menu (G). Masterplan sorts
the data you have selected in the order specified. Once the data is sorted,
Masterplan resumes the Ready mode.

Quit

The Quit command is used to return to the Ready mode in the same
position that you were in before issuing the Range Sort command. This
command can be used at any time between selecting Range Sort and issuing
the Go command.
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GRAPH COMMANDS
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The Graph Menu

Graph commands create visual presentations of your worksheet’s data.
Masterplan Graphs are dramatic, effective and easy to create. As in other
areas managed by Masterplan, the Graph commands are extensive and
versatile enough to meet your particular needs and yet simple enough to use.

There are four different types of graphs you can create, along with several
different options available with each graph (such as adding titles and labels),
You can even switch from one type of graph to another. Masterplan offers
you a tremendous amount of latitude in creating the type of graph that best
suits your purpose.
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Creating and Viewing Graphs

When you create a graph, there are only two decisions you are required to
make. The first is the type of graph and the second is which range from the
worksheet you want represented. All other decisions and embellishments are
optional.

When you are ready to view a graph, you may use the Graph View
command or, if you are in the Ready mode and all your graph settings have
been made, click on the Graph icon in the control panel or use the Graph
function, [Function 10]. If you try to view a graph without having made the
appropriate settings, Masterplan will display a Dialog box telling you so.

Masterplan displays your graph in a separate Graph window. Graph
windows are similar to worksheet windows in several ways. Like worksheet
windows, a graph window may be made smaller using the Size Box located in
the lower right corner. It may be moved around the screen by dragging the
mouse while the pointer is over the Title bar. It has a Full box in the upper
right corner which allows you to expand the window to fill the screen. Then,
with the next click of the mouse over the Full box, the window will return to

its former size. The Quit box in the upper left corner allows you to close the
Graph window.

Masterplan graphs have an interesting feature which ties in with the size of
the Graph window. If you change the Graph window sc that it is wide and
short, your graph will change proportionately so that it too is wide and short.
If the Graph window is thin and tall, your graph will also be thin and tall.
If you make a graph window very small, it will start cutting off sections of
the graph display.

After viewing a graph, you may close the Graph window in one of two
methods. While the Graph window is active, press any key or click on the
Close box. When you are ready to view it again, you may use the Graph
View command or if you are in the Ready mode, click on the Graph icon in
the control panel or use the Graph function, [Function 10] to redraw the
graph.
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If you are using a mouse, there is no need to close your Graph window
when you want to go back to your worksheet. You can simply switch from
one window to another by moving the mouse pointer to the window you want
active and clicking on the mouse button. The active window is always placed
on top of the inactive window in the areas where they overlap. This feature
is handy because it allows you to make quick changes to your worksheet and
then click on the Graph window to immediately see these changes reflected
in your graph. Full, Size and Close boxes are not available on an inactive
window.

It may appear as though a worksheet or graph disappears when it is not
active because of the overlapping feature. If this should happen, make the
active window small and use the Title bar to move it around the screen until
you can see the inactive window beneath it. When you click the mouse
button over the inactive window, it will become active.

Graph Type

There are four types of graphs offered by Masterplan: Bar graph, Stacked-
bar graph, Line graph and Pie graph. The first three types of graphs can
represent different values for up to six sets, or ranges, of related data. The
Pie graph represents percentages of different data values for a single set
(range) of data. Stacked-bar and Pie graphs should not be used to show both
positive and negative values at the same time.

Bar Graphs

A Bar graph is probably the simplest type of graph you can create and the
easiest to represent different sets of data with. Bar graphs compare one or
more series of values. They use a horizontal basis to line up the sets of data.
Each piece of data is represented by a rising vertical bar. Each bar is drawn
to scale and is adjusted to the height which indicates its value.
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Stacked-bar Graphs

A Stacked-bar graph is similar to a Bar graph in that it uses rising vertical
bars to represent data. However, only one set of data extends across the
horizontal basis. The other sets of data are stacked on the first set. Its best
use is for comparing consecutive values of data from several sets.
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Stacked-bar Graph
Line Graphs

A Line graph uses a scale to show amounts or values in a vertical fashion.
The sets of data are lined up horizontally below the graph. The values are
indicated by lines, labels and/or symbols at the height which represents their
amount or value. Like the Bar graph, the Line graph is mainly used to
compare one or more series of values.

Although it is called a Line graph, Line graphs do not necessarily use lines
to depict sets of data. There are four options you may use singly or in
combination to show the values in a Line graph. To select the format of
your line graph, use the Graph Options Format or Graph Options Data-labels
command.
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The first option is using symbols to represent different sets of data. Each
set of data uses a different symbol and each piece of data is represented by
the symbol of its set. The symbol is placed directly above its item on the
horizontal axis (base) at the height which indicates its place on the scale.

In place of symbols, you may use data labels to depict the values on your
graph. The data labels are chosen from a range in your worksheet and each
point on the graph is represented by its own label.

A third option is using a line to indicate the position of each item of data
on the scale. Imagine using an invisible dot to pinpoint the data’s position on
the scale. Then draw a line connecting the dots from the left to the right
side of the graph. One line is used for each range of data. This is the line
option.

A fourth option is using a combination of the line and symbol. A line is
drawn across the graph to represent the position of each item of data in a
range. Then the position of each item is further emphasized by the symbol
representing its range.
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Pie Graphs

A Pie graph is round and divides one set of data into slices. The size of
these slices depends on the percentage value of each piece of data with
respect to that of the entire range. Masterplan considers the entire graph to
be 100% of the range. It automatically calculates a percentage for each slice
(which is rounded off to one decimal place). The total of the individual
slices is 100% or as close as possible. Pie graphs best represent how one piece
of data affects the entire set. Masterplan Pie graphs display the first slice
(item of data in the range) as exploded away from the rest of the pie.
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Selecting a Graph Type

Select the Type command from the Graph menu (/GT). Then select Bar
(B), Stacked-bar (S), Line (L) or Pie (P). It is a good idea to select the type
of graph and all the options you want to use with it and then view it after
you’ve made all your selections. Masterplan will not display your graph until
you use the Graph View command.

Changing Graph Types

To Change from one graph type to another while still representing the same
data, select a new type. Then reselect View from the Graph menu to see the
new graph.

Gra ph X (An X Axis for Optional Data or Labels)

The X command is used to specify an X axis (the horizontal axis). With
Bar, Stacked-bar and Line graphs, this command can be used to place
optional labels below the horizontal border. With Pie graphs, the labels are
positioned to the right of the Pie.

Select the X command from the Graph menu (/GX). Then specify and
enter a range of labels or values from the worksheet in response to the
prompt. You may find you need to create one which suits your needs
beforehand. Masterplan automatically does the rest of the work. Notice that
X labels are not limited to label entries but can also be numbers or formulas.

Graph A,B,C,D,EorF

These six letters (A, B, C, D, E and F) are used to select the different sets
of data needed for the graph by using a cell range from the worksheet. Since
at least one cell range must be indicated, selecting A is mandatory. Select A
from the Graph menu (/GA). Now specify the cell range from your
worksheet and enter it in response to the prompt. Actually, for all graphs
except Pies, you may substitute any other range (B - F) for A. Specifying
the A range is only mandatory for Pie graphs.
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There are two things to remember when deciding which data from a
worksheet to use in a graph. The first is that the amount of data should be
kept down to a manageable level. The second is that, to make sense, the data
should have some common theme. Frequently, the data you want to use for
your graph ranges cannot be found in one convenient range. At times, you
may even want to contrast distant parts of your worksheet in a graph. When
this happens, copy the cells you want to use into an unused portion of the
worksheet so that you can use the range command on them there.

After you have selected a primary range with Graph A (or a substitute
range) command, you may decide you wish to compare similar sets of data
with it. Select letters B - F the same way you did A and specify a range for
each. The additional sets of data you choose will be integrated with that of
A. The first values of each range will be grouped together, then the second
values of each range are grouped together and so on.

Masterplan sets apart each range by displaying a different color. With a
Monochrome system the ranges are displayed in different shades from white,
through gray to black. The colors used are determined by the settings you
made from the Control Panel in the Desk menu.

Graph Reset

The Reset command allows you to erase graph type and range settings for
an entire graph, just for the graph type or for individual range settings.
What is reset depends on which option you select with the Reset command.
Usually this command is used after you have viewed a graph and wish to
eliminate a range or ranges from a graph or set new ranges.

Select the Reset command (R), then the option that you want reset. Graph
(G) erases the entire graph from memory. X erases labels from the X range.
A thru F erase individual range settings. Masterplan acts as though you had
never specified that graph, type or range setting. However, if it was a data
range that was reset, the legend and format selected for it is retained. If you
select another data range to replace the one that was reset, the legends and
format will be reused.
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Graph View

The Graph View command is used to see your graph after you have
selected all necessary ranges and options for it. Select the View command
from the Graph menu (/GV). Graph settings will be remembered while the
original worksheet is still in use, even if you are no longer viewing the graph.

When you display a graph, you may decide to have both the Graph and
Worksheet windows on the screen at the same time. Resize the windows
without closing the Graph window and arrange them in a convenient fashion.
To move from one window to the other, move the mouse pointer to the
window you want active and click on the mouse button. Make some changes
to the worksheet, then click on the Graph window. The results of your
changes will be reflected in the Graph window as soon as you click in it.

Graph Options

The Graph Options commands are a set of optional commands which allow
you to do such things as adding legends and deciding the format for your
graphs. They are used for aesthetic purposes and to offer additional
information about the graph.

To display the Options menu, select Options from the main Graph menu
(/GO). You may select as many options as you want before returning to the
main Graph menu or the Ready mode. Quit (Q) will take you out of the
Graph Options menu. [Escape] or clicking on the Cancel icon can also be
used.
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The Graph Options
Graph Options Legend

The Graph Options Legend command controls labels which act as keys to
your graph elements. The legends are assigned to each of the colors used in
your graph. Legends are ignored with Pie Graphs.

Select the Legend command from the Graph Options menu (/GOL). Then
select the data range, A thru F. The most recent legend for that range is
displayed. If you accept it as is, press [Return] and continue with your work.

A legend is a label which can be up to 19 characters long. For the sake of
the display, we suggest that you keep legends as short as possible. Sometimes
you may find that, when you specify legends, the screen will display more
characters than can be displayed.

In addition to typing in legends, you can also use a cell’s contents as a
legend. To use a cell’s contents, specify the Graph Options Legend command
just as you would otherwise, only instead of typing the legend, type a
backslash "\" followed by a cell address or a range name and press [Return].
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Using Legends with a Bar Graph

If you choose a range name, Masterplan will use the contents of the top left
cell of the range as the legend. If you use a cell’s contents as a legend,
Masterplan considers the reference to be absolute. If the cell’s contents are
changed or transferred to another area, Masterplan continues to use whatever
contents are still at the same cell address.

The next time you view your graph, the legends will be displayed at the
side of the screen. If you reset the corresponding data range, Masterplan no
longer displays the legend but it is retained. When you specify another range
to take the place of the first one, the legend will reappear.

Masterplan stays in the Options menu until you use Quit to return to the
main Graph menu. If you wish to specify another range, select Legend (L)
again and specify your new range and legend.

Graph Options Format

The Graph Options Format command determines the way data points are
shown or connected in line graphs. The options include using a line to
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connect all the points from one range, symbols to show all the data points
(each using a different symbol), neither lines nor symbols or both connecting
lines and symbols for the points.

Select Format from the Graph Options menu, (/GOF). To set an overall
format, select Graph, (G). To select a particular range from the graph, select
the range by its letter, (A thru F). Now select the type of format you wish
to use, Lines (L), Symbols (S), Both (B) or Neither (N). If you select
Neither, you will have to use the Graph Options Data-labels command to
designate your ranges.

The Next time you view your graph, the selected formats will be displayed.
Masterplan stays in the Format menu after you have chosen a format option.
You may format additional ranges or select Quit (Q) to return to the Options
menu.
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Selecting the Symbols Option for Line Graphs

Data-labels
The Graph Options Data-labels command is used to specify a range of cells

from the worksheet whose contents will be used to label the data points from
a given range (A - F) in all except Pie graphs.
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Select the Data-labels command from the Graph Options menu (/GOD).
Select the letter of the data range you want to label (A - F). Now specify
the range of cells from the worksheet which you want to use as labels. Any
formula or number will be converted to a label according to its current value
and the Range or Worksheet command affecting its cell format before it is
displayed in the graph. If you previously selected a range, it will be
displayed. As the last step, select the alignment of the labels to the data
points , Centered (C), Left (L), Above (A), Right (R) or Below (B). For Bar
graphs, always select Above for bars with positive values and Below for bars
with negative values.

The next time you view the graph, your data labels will be displayed in the
positions you specified. Masterplan stays in the Data-labels menu until you
use the Quit command (Q). If you use the Graph Reset command to erase a
range at some later time, you will also erase the data labels from that range.

Graph Options Titles

The Graph Options Titles command is used to title the entire graph with a
main title and/or a subtitle or individual titles (X and/or Y).

Select the Titles command from the Graph Options menu, (/GOT). Now
select the First line (F) in the graph title, the Second line (S) in the graph
title, a title for the X (horizontal) axis (X) or a title for the Y (vertical) axis
(Y). The last title used for your option will be displayed. To accept it, press
[Return]. To change it press [Escape], and enter the title of your choice.
Masterplan will place you in the Edit mode to make writing and revising
easier. You may use up to 39 characters in a title. However, we suggest that
titles, like legends, be kept as short as possible.

Instead of typing a title, you may use the contents of a cell as a title. To
do so, start your title entry with a backslash "\" and either type the cell
address or range name. Press [Return]. If you type a range name, the cell
contents of its top left cell will be used. The contents of the location you
specified will be used as the current title. Numbers and formulas assume
their current values and can also be used as titles.
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When the new titles are displayed, both graph titles (First and Second) are
centered at the top of the graph. X axis titles appear below the horizontal
axis and Y axis titles appear parallel to and to the left of the vertical axis.
Masterplan stays in the Options menu until you issue the Quit command (Q)
to go back to the main Graph menu.

Graph Options Grid

The Graph Options Grid command is used to add horizontal, vertical, both
horizontal and vertical or remove all grid lines from all but Pie graphs.

Select the Grid command from the Graph Options menu, (/GOG). Your
options are Horizontal (H), Vertical (V) or Both (B). To remove all grid
lines, select the Clear (C) option.

If grid lines are added, they will appear at each scale mark in the direction
you specified. Scale marks are "ticks" set at equal distances along the X and
Y axes. These measurements decide how each piece of data is represented by
adjusting its value to scale. If all lines are removed, the grid lines are no
longer visible although the ticks are still displayed.

Graph Options Scale

The Graph Options Scale command allows you to move between automatic
and manual scale settings for the Y-scale for all but Pie graphs. It also
allows you to specify a "Skip" factor for the X-axis labels.

Scaling is initially set to Automatic. Once you’ve selected the data for your
graph, Masterplan decides what increments to use for scaling. For example,
if each piece of data you chose for a Bar graph varies by about ten points,
then the increment for the scale numbers will be ten points. The scale
numbers and ticks showing the scale numbers rising incrementally are lined
up vertically along the Y axis. How many scale numbers (increments) are
used depends mainly on the highest and lowest values.
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If you change the scaling to Manual, you can change the upper and lower
limits of scaling but you will not be able to change the scale increments
yourself. The increments are modified by the changes you make in upper
and lower limits.

To use the command, select Scale from the Graph Options menu, (/GOS).
Then select Y-axis or Skip factor (S). If you selected Y-axis, you will have
to specify Automatic (A) or Manual (M). Scaling is initially set to
Automatic. If Manual is selected, specify an Upper (U) and Lower (L) scale
limit and press [Return]. To insure that the Scale includes zero in Bar and
Stacked-bar, Masterplan ignores a positive Lower scale limit or a negative
Upper scale limit.

For both Manual and Automatic scaling, Masterplan uses round numbers as
upper and lower limits. Although you set the limits with Manual scaling,
Masterplan can only use the round numbers which are closest to the limits
you specify. "Tick" marks are drawn next to each scale number, evenly
spaced along the axis. If a range of data point values is too varied (for
example, a range which has some values differing by 5 or 10 points but
whose lowest and highest values differ by one or two million), the highest
values may not be able to fit on the graph and will be excluded. Otherwise,
Masterplan tries to include all the data values in the graph. If you have set a
scale too small to include all the values of a data range, Masterplan adds to
the scale until the entire graph has been filled.

If you select the Skip command (S), you will need to specify the number
for the Skip factor. Then, starting from one, every nth entry will be taken
from the X range and used as a label along the X (horizontal) axis. For
example, if five is the Skip factor, the first, sixth, eleventh, etc. entries from
the range are used as graph values.

When you use the Graph Options Scale commands, Masterplan stays in the
Scale menu until you select Quit (Q) to return to the Graph Options menu.

Graph Options Scale Y-scale Format

The Graph Options Scale Y-scale Format command allows you to control
the format in which scale numbers on a graph are displayed. Pie graphs are
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ignored by this command. The initial setting is the General Format. This is
a fairly standard format choice, but with Masterplan, you have an additional
seven selections: Fixed, Scientific, Currency, Comma (","), Percent, Date or
Text. These formats are the same as those described under "Worksheet
Format" in the Worksheet commands chapter.

Select the Format command from the Graph Options Scale Y-scale menu,
(/GOSYF). Select your desired format. Then enter the additional
information (like number of decimal places) and press [Return] or click OK.
The next time you view your graph, the scale numbers will be set to the
format you selected.

Graph Print

The Graph Print commands govern printing the current graph, advancing to
the top or the next page after printing and saving the Graph picture to a
picture file that can be loaded into other programs for further enhancements.
The printer characteristics are determined by the Install Printer selection
from the Desk menu.

Print Graph

The Print Graph command sends the current graph displayed to the printer
using GEM’s screen print commands. It is compatible with all printers that
work with GEM. Its settings are controlled by the Install Printer selection
from the Desk menu. Before you print your graph, size and position the
graph where you would like it on the screen. Next, make sure your printer is
turned on and the paper is positioned at top-of-form.

Select Print Graph from the Graph Print menu. (/GPP). Your graph with

all current settings and formats will be sent to the printer. The print
command does not require confirmation before it prints.
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Advance Paper

The Advance paper command is used to advance to the top of the next
piece of paper after a graph has been printed. If this command is not used,
the next graph will be printed immediately following the first.

After printing a graph, select the Advance Paper command from the Graph
Print menu, (/GPA). Your paper will be advanced to the top of the next
sheet, ready to print another graph. This command is optional.

Save

The Graph Print Save command is used to save a copy of your current
graph to a picture file on the disk in the Degas format. These picture files
can then be loaded into Degas or Degas Elite for further enhancements.
Picture files are saved to the disk with one of two file extensions: ".PI2" for
Degas color and ".PI3" for Degas monochrome picture formats.

To save a graph, select the Save command from the Graph Print menu,
(/GPS). Next, specify the file name you wish to use in the File Selector Box,
up to eight characters, and click OK. You don’t have to worry about the file
extension. Masterplan will save the current graph to the disk using the name
you specified and will add the appropriate extension of the picture type you
selected. As with the Print command, you can size and position the graph
anywhere on the screen before you save your graph.

Graph Quit

The Graph Quit command allows you to leave the main Graph menu and
return to the Ready mode. As you have noticed, once you enter the Graph
menu, you remain there until you use the Quit command, Break or [Escape].
Select Quit from the Graph menu, (/GQ) to return to the Ready mode.
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Ditek™ Int'l License Agreement

IMPORTANT- READ CAREFULLY

DITEK INT'L SOFTWARE LICENSE AND LIMITED WARRANTY

THIS LEGAL DOCUMENT IS AN AGREEMENT BETWEEN YOU, THE END USER, AND DITEK INT'L.
BY OPENING THIS SEALED PACKAGE, YOU ARE AGREEING TO BECOME BOUND BY THE TERMS
OF THIS AGREEMENT, WHICH INCLUDES THE SOFTWARE LICENSE, LIMITED WARRANTY, AND
ACKNOWLEDGEMENT .

In order to preserve and protect its rights under applicable law, Ditek Int'l
does not sell any rights in Ditek Int'l SOFTWARE. Rather, Ditek Int'l grants
the right to use Ditek Int'l SOFTWARE by means of a SOFTWARE LICENSE. Ditek
Int'l specifically retains title to all Ditek Int'l computer software.

1. GRANT of LICENSE. In consideration of payment of the LICENSE fee which is
a part of the price you paid for this product, and your agreement to abide by
the terms and conditions of this LICENSE and the Limited Warranty, Ditek Int'l,
as Licensor, grants. to you, the LICENSEE, a nonexclusive right to use and
display this copy of an Ditek Int'l software program (hereinafter called
"SOFTWARE") on a single COMPUTER (ie. with a single CPU) at a single location
so long as you comply with the terms of LICENSE. If the single computer on
which you use the SOFTWARE is a multiuser system, the LICENSE covers all users
of that single system, without further LICENSE payments. Ditek Int'l reserves
all rights not expressly granted to LICENSEE.

2 OWNERSHIP OF LICENSE. As the LICENSEE, you own the magnetic or other
physical media on which the SOFTWARE is originally or subsequently recorded or
fixed, but an express condition of this LICENSE is that Ditek Int'l retains
title and ownership of the SOFTWARE recorded on the original disk copy(ies) and
all subsequent copies of the SOFTWARE, regardless of the form or media in or on
which the original and other copies may exist. This LICENSE is not a sale of
the original SOFTWARE or any copy.

&y COPY RESTRICTIONS. This SOFTWARE and the accompanying written materials
are copyrighted. Unauthorized copying of the SOFTWARE, including SOFTWARE
which has been modified, merged, or included with other software, or of the
written materials is expressly forbidden. You may be held legally responsible
for any copyright infringement which is caused or encouraged by your failure to
abide by the terms of this LICENSE.

Subject to the restrictions above, and if the SOFTWARE is not
copyprotected, you may make one (1) copy of the SOFTWARE sclely for backup

purposes. You must reproduce and include the copyright notice on the backup
copy.
4. USE RESTRICTIONS. As the LICENSEE, you may physically transfer the

SOFTWARE from one computer to another provided that the SOFTWARE is used on
only one computer at a time. You may not electronically transfer the software
from one computer to another over a network. You may not distribute copies
of the program or the associated documentation to others. You may not
modify, adapt, translate, reverse engineer, decompile, disassemble, or create
derivative works based on the written materials without the prior consent of
Ditek Int'l.




8. TRANSFER RESTRICTIONS. This SOFTWARE is licensed only to you, the
LICENSEE, and may not be transferred to anyone without the prior written
consent of Ditek Int'l. Any authorized transferee of the SOFTWARE shall be
bound by the terms and conditions of this LICENSE and Limited Warranty. In no
event may you transfer, assign, rent, lease, sell or otherwise dispose of the
SOFTWARE on a temporary or permanent basis except as expressly provided herein.

6. TERMINATION: This license is effective until terminated. This license will
terminate automatically and without notice from Ditek Int'l if you fail to
comply with any term or condition of this license agreement. Upon termination,
you shall destroy the written materials and all copies of the SOFTWARE,
including but not limited to modified copies, originals, and backups made of
the originals if any.

7. UPDATE POLICY: Ditek Int'l may create, from time to time, update versions
of the SOFTWARE. At its option, Ditek Int'l will make such updates available
to the LICENSEE and Transferees who have paid the update fee and returned their
registration card to Ditek Int'l.

& MISC: This LICENSE Agreement shall be governed by the laws of the
Province of Ontario, Canada, and shall inure to the benefit of Ditek Int'l,
it's successors, administrators, heirs and assigns.

DISCLAIMER OF WARRANTY AND LIMITED WARRANTY

This SOFTWARE and accompanying written materials are provided "as is"
without warranty of any kind. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE
OF THIS SOFTWARE IS ASSUMED BY YOU. SHOULD THE SOFTWARE PROVE DEFECTIVE IN
USE, YOU (AND NOT Ditek Int'l OR IT'S AGENTS) ASSUME THE ENTIRE COST OF ALL
NECESSARY SERVICING, REPAIR OR CORRECTION OF DATA. FURTHER, Ditek Int'l DOES
NOT WARRANT, GUARANTEE OR MAKE ANY REPRESENTATIONS REGARDING THE USE
OF, OR THE RESULTS OF THE USE OF THE SOFTWARE IN TERMS OF CORRECTNESS,
ACCURACY., RELIABILITY, CURRENTNESS, OR OTHERWISE AND YOU RELY ON THE
SOFTWARE AND RESULTS AT YOUR OWN RISK.

Ditek Int'l warrants to the original licensee that the disk(s) on which
the SOFTWARE is recorded is free from defects in materials and workmanship
under normal use and service for a period of ninety (90) days from the date
of delivery as evidenced by a copy of your receipt. Ditek Int'l's entire
liability and your exclusive remedy shall be, at Ditek Int'l's option,
replacement of the disk not meeting Ditek Int'l's Limited Warranty and which is
returned to Ditek Int'l with a copy of your receipt. If failure of the
disk has resulted from accident. abuse or misapplication of the
product, then Ditek Int'l shall have no responsibility to replace the
product under this warranty.

THE ABOVE IS THE ONLY WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE, THAT IS MADE BY Ditek Int'l ON THIS Ditek
Int'l PRODUCT, THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO
HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE. NEITHER Ditek Int'l NOR
ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION OR DELIVERY
OF THIS PRODUCT SHALL BE LIABLE FOR ANY DIRECT, INDIRECT,
CONSEQUENTIAL, OR INCIDENTAL DAMAGES ARISING OUT OF THE USE, THE RESULTS OF
USE, OR INABILITY TO USE SUCH PRODUCT, EVEN IF Ditek Int'l HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES OR CLAIM.

ACKNOWLEDGEMENT
You acknowledge that you have read this LICENSE and Limited Warranty.
understand them, and agree to be bound by their terms and conditions. You also
agree that the LICENSE and Limited Warranty are the complete and exclusive
statement between the parties and supersede all other communications between
the parties relating to the subject matter of the LICENSE or the Limited
Warranty.
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